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Getting Started

This guide is intended to help you transition from using AutoCAD® Land Desktop to using
AutoCAD® Civil 3D® as your primary engineering design application. It will help you
understand the many benefits of moving to Civil 3D, how your current workflows may change
as a result of the move, and how to prepare for the move.

This guide will be helpful for individual civil engineers, designers, surveyors, and drafters who
are moving to Civil 3D, as well as for IT and CAD managers who are assessing the overall
process of moving to Civil 3D.

Why Move to Civil 3D?

Perhaps your organization has already made the decision to move from Land
Desktop to Civil 3D. If so this chapter reinforces why that decision was the right
one. If your organization is still in the process of evaluating whether it should
move from Land Desktop to Civil 3D, this chapter will help you understand
the compelling arguments for doing so.

The following sections describe some of the important benefits you'll realize by
moving from Land Desktop to Civil 3D.

Dynamic Model-Based Design

Projects created with Civil 3D use a dynamic engineering model that links design
and production drafting. As a result, a change to one part of the design
propagates throughout the entire project, greatly reducing drafting errors as
well as the time it takes to implement design changes and evaluate multiple
design scenarios. For example, if you adjust the vertical design alignment, Civil
3D automatically updates the road model, redisplays proposed contours,
recalculates volumes, updates profile labels, and corrects section plots for the
road. If you change the curve length on your alignment, the profile, corridor
model, and plotted cross sections are all updated. If you lower a building pad,



you can immediately retrieve updated volumes and display the new limits of
construction. Civil 3D effectively maps the civil engineer’s work process into
an easy-to-use and powerful software environment, saving time and money,
and reducing errors.

Better Control of Standards

Civil 3D allows you to easily deploy and automatically enforce organizational
standards for design data by employing style features that are built directly
into drawing templates (*.dwt files).

A variety of drawing templates with predefined styles comes with Civil 3D.
These can be used as a starting point for creating your own custom templates
and styles. Typically in an organization, custom drawing templates are created
and maintained either by one or by a few persons, and shared with the team
or teams. A CAD manager can store the templates in a read-only location
where the rest of the team can access and use them, but not modify them.

When new styles are needed, it is just a matter of updating the template from
the current drawing, or updating the current drawing from a template. New
styles can be dragged from one drawing into a template using the Civil 3D
Toolspace. Chapter 3 (page 69) of this guide discusses the use of styles and
templates in more detail.

Cutting Edge Technology

At the time it was introduced, Land Desktop represented best in class
technology for automating standard engineering processes. Many organizations
have been using Land Desktop for as long as a decade, proving that it is a
dependable platform for creating construction documents for the civil
engineering industry; however, the technology platform on which Land
Desktop is designed has evolved to its limit.

Civil 3D was built from the ground up to be completely integrated with
AutoCAD—the world’s most widely used CAD platform. It is designed to
support all types of civil engineering projects, from site design and local roads,
to major highways and interchanges, and utilizes three-dimensional, dynamic,
model-based design technology. This advanced technology provides you with
a whole new set of tools and workflows that will let you create and evaluate
designs faster and more precisely.

Increase Design Alternatives

The Civil 3D dynamic engineering model lets you explore conceptual proposals
and complete final designs faster than in Land Desktop. For example, you can
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begin by quickly laying out various alignment alternatives for a proposed
roadway. You can then begin refining alignments, profiles, and the makeup
of the roadway cross section until the best design proposal has been developed.
With each change, all related objects and drawings are updated automatically.
This functionality allows you to evaluate more design alternatives in less time,
providing your customers with a higher level of service and differentiating
your firm from the competition.

Create Plan and Profile Sheets Faster

Civil 3D provides an environment where drafting is derived directly from the
model using display styles. The style-based environment helps to ensure that
objects and annotation in the drawing conform to production standards. Civil
3D also provides civil/survey-specific drafting tools and advanced drafting
features, such as the Plan Production Tool wizards for roadway sheet
generation. Tools such as these automate what would typically involve
numerous steps in Land Desktop, resulting in improved production drafting
efficiency.

Dynamically Link Designs with Production Drafting

Civil 3D dynamically links drafting elements, such as alignment or parcel
labels and tables, with the engineering model so that a change to any part of
the model produces updated annotation automatically. These intelligent labels
and tables also reflect any changes in the drawing scale and view orientation.
For example, if you change the scale of the plan from 1:50 to 1:100, the
annotation automatically resizes to maintain the proper size in completed
construction documents. If you rotate the view orientation of the plan, the
annotation of the objects automatically rotate to maintain plan readability.
Automatic updating minimizes time-consuming and costly manual editing
of drafting elements and helps ensure the accuracy of your final construction
documentation. This minimizes the need to redraft when design changes
occur. After your drafting is generated, the model and Civil 3D annotation
remain in sync.

Advanced Data Sharing and Project Management

Civil 3D has scalable, multiuser data sharing and project management
functionality that includes the use of AutoCAD xrefs, data shortcuts, and
project management support based on Autodesk® Vault. These features help
small and large project teams complete projects more quickly and with less
risk of errors. Multiple members of a design team can access items such as
survey observations, points, surfaces, alignments, profiles, corridor models,
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and pipe networks so that multiple people in different departments can work
on a project simultaneously. You can share an alignment across multiple
drawings—while each drawing has different annotation and object appearance.
If the master alignment changes, the alignment in all your secondary drawings
is updated automatically. There is no need to re-create any drafting—plan and
profile remain in sync. By using one or more of these features, everyone on
the team can work on files simultaneously, and be assured that everyone is
using the most up-to-date project data.

Data Compatibility

You can use Civil 3D to work with any DWG™ drawing files, read and write
MicroStation® DGN drawing files, and import and export Land Desktop project
data. Civil 3D also works with LandXML data and GIS data formats, including
ARC/INFO® coverages and Export (E00), ArcView® Shape, and more, allowing
you to do conceptual studies using free or low cost data from various sources.
You can also use Civil 3D to export model graphics and metadata for use
outside of Civil 3D. For example, a published DWF™ file includes all of the
model data, such as pipe size and material, so that people reviewing the design
in Autodesk® Design Review can have all the information they need to validate
the proposal.

Using Civil 3D, you can export model elements, such as parcels, pipes, and
alignments, to SDF format for use in GIS applications, such as AutoCAD® Map
3D, Autodesk MapGuide® Enterprise, or Autodesk® Topobase™ software. Civil
3D also supports interfacing with the industry-leading data collectors from
companies such as Leica, Trimble, and Carlson. Civil 3D data compatibility
creates an integrated CAD and GIS solution that makes it easier to work with
both internal and external engineering and GIS departments or consultants.

Visualization and Rendering Features

Civil 3D includes all of the rendering capabilities of AutoCAD software. These
features help you quickly communicate design proposals. For example, drawing
elements representing roadway components can be rendered with specific
materials so that they automatically render a particular surface or subsurface
material. Surface models can be easily broken into subareas that display as
different materials. The rendering features are easy to use and handle a range
of detail, from simple shading to photorealistic images. Civil 3D also includes
utilities to help you integrate your design models into the Google Earth™
mapping interface for quickly communicating design intent to nontechnical
audiences.
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Because Civil 3D is built on AutoCAD software, experienced AutoCAD users
can work in a familiar environment, with tools and processes they already
know, while also taking advantage of the engineering, surveying, and
industry-specific drafting tools that are native to Civil 3D.

Civil 3D Features and Benefits

This section discusses in more specific terms some of the key Civil 3D design
features that will provide significant benefits compared to Land Desktop.

Better Project and File Management Features

Unlike the project management solution in Land Desktop, the project
management solution in Civil 3D is a scalable, comprehensive multi-user
project management system that provides project teams with appropriate
levels of access to the data they need. It facilitates the organization of files,
distribution of files over a network, version control, check-in and check-out,
and rollbacks. Civil 3D includes a range of file management features that suit
varying levels of project management needs—from drawing-based shortcuts
and xrefs to the full-scale project management solution features.

The Civil 3D project management solution leverages the data management
capabilities of Autodesk® Vault to allow project teams to work more efficiently
and with less risk of coordination errors as modifications occur in the project
cycle. For more information about the project management solution in Civil
3D, and how to integrate these features into your workflows, see Chapter 5.

Improved Point Features

Create points using a variety of coordinate geometry (COGO) and graphical
methods. Because Civil 3D points are a part of the engineering model, and
not maintained in an external file, changes made to the points are dynamically
reflected in the model. For more information about Civil 3D point
functionality, and how it compares to Land Desktop point functionality, see
Chapter 2.

Improved Surface Features

Build surfaces from a variety of 3D source data. Analyze contours, slope,
elevation, and watershed areas, and update contours, volumes, and surface
analysis instantly when making surface edits. Civil 3D updates surfaces when
data is added or edited, and rebuilds the surface when data is removed. For
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more information about Civil 3D surface functionality, and how it compares
to Land Desktop surface functionality, see Chapter 2.

Improved Parcel Features

Dynamic relationships mean that parcel collections are always up-to-date.
Civil 3D integrates parcels that are within a single site topology, so a change
to one parcel creates related changes in neighboring parcels.

Improved Alignment Features

The Civil 3D alignment object includes tangent, curve, and spiral features and
enables the addition of any labeling required in the finished plans. You can
edit using a tabular editor or graphical interface to automatically update the
alignment’s labeling. You can also share alignment and profile data across
drawings for use by multiple project team members. For more information
about how you work with alignments in Civil 3D, see Chapter 2.

Improved Profile Features

Extract profiles of multiple surfaces based on alignment geometry,
automatically control the profile appearance and annotation based on the
styles that you select, and update profile labeling and drafting dynamically.
For more information about how you work with profiles in Civil 3D, see
Chapter 2.

Improved Corridor Modeling Features

Generate a dynamic model of any road, rail, or corridor project by using design
elements—such as alignments, profiles, superelevation, and other design
criteria—that can apply constraints and other customized behavior into the
model. Changes made to the elements that were used to create the model
result in updated corridor volumes, surfaces, sections, and other analysis and
output. Civil 3D provides real-time editing of individual stations or station
ranges along the road. These are just some of the advanced road modeling
features that are only available in Civil 3D.

Improved Subassembly Catalog

Civil 3D provides you with a catalog of approximately 100 preconfigured
subassemblies of typical roadway components such as lanes, curbs, sidewalls,
ditches, rails, and even a basic bridge. You can use these as is in your model
or use them as starting points to design your own catalog of custom
components for typical roadway sections (assemblies). They are easily accessible
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from a convenient Tool Palette that includes graphical representations of the
shapes.

Improved Section Features

Extract and draft surface and corridor sections. Select sections at specific
stations, at intervals along alignments, or at specific points, and create section
plots for a single station or full section sheets.

Improved Site Grading Features

Combine multiple grading elements into one group to find solutions for
complex grading problems. Grade into surface, elevation, or distance targets.
Balance cut/fill volumes dynamically for an entire site or a single grading
object. Build a static or dynamic surface from grading groups. While similar
tools exist in Land Desktop, you will quickly find that the way they function
in Civil 3D is simpler, more intuitive, and more feature-rich.

Improved Pipe Features

Lay out sanitary and storm drainage systems as dynamic, interactive pipe
networks. You can make changes to pipes and structures using graphical as
well as numeric input. Changes to a pipe network automatically update the
drafting (labels). You can plot and complete final drafting of the pipe network
in plan, profile, and section views, and you can use rendering and visualization
features to produce realistic representations.

In addition, an easy-to-use graphical interference-checking feature lets you
quickly identify pipe network parts that collide with each other or exist in
undesirable locations. You can also share pipe network information, such as
pipe and structure material and size, with external analysis applications.

Hydraulics and Hydrology Features

Civil 3D includes three software extensions that enable you to perform storm
water hydraulics and hydrology tasks, including storm sewer design, watershed
analysis, detention pond modeling, and culvert analysis.

The Hydraflow Storm Sewers Extension is a comprehensive solution for
watershed analysis and detention pond design, from simple sites to complex
watersheds with interconnected ponds. You can automatically design pipes,
inverts, slopes, and inlets based on user-defined parameters, and interactively
modify and optimize your system in real time, assuring that your Civil 3D
designs have the highest hydraulic efficiency at the lowest possible cost.
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The Hydraflow Hydrographs Extension is used for pond design and modeling
of simple or complex watersheds using the SCS and/or Rational methods. You
can perform a host of functions, including hydrograph combining, channel
reach and reservoir routing, and hydrograph diverting.

The Hydraflow Express Extension provides flexible calculators for performing
a wide variety of hydraulics and hydrology tasks for designing culverts, open
channels, inlets, hydrology, and weirs. You can quickly produce informative
graphs, rating curves, and professional, easy-to-read reports.

These three extensions come with Civil 3D. They bring easy-to-use,
industry-leading hydraulics and hydrology software to Civil 3D users, providing
significant productivity improvements over Land Desktop hydraulics and
hydrology features, as well as providing additional features that are not present
in Land Desktop.

Improved Survey Features

The survey features in Civil 3D provide a consistent environment for
performing survey tasks such as using the Survey Data Collection Link to
convert raw data to field book files for importing, as well as functionality for
least squares adjustment, editing survey observations, and reporting tolerance
errors. With the Mapcheck Analysis command, you can check survey figures
and parcels for closure, based on label direction and distance values. The
Mapcheck Analysis command can also be used to check manually input data
for closure errors, and to subsequently adjust and create AutoCAD polyline
objects. Editing survey figures is simplified by using feature line editing
commands available from the Survey menu.

Preparing for the Move

This section describes the items you should consider before you move from
Land Desktop to Civil 3D.

Assessing Current Workflows

The first step in moving from Land Desktop to Civil 3D is to assess your
organization’s current workflows for designing and delivering engineering
design projects. A clear understanding of your current workflows and processes
will help you implement Civil 3D software successfully and be better able to
validate results. For example, is your current workflow documented in any

8 | Chapter | Getting Started



way, either at a conceptual or detail level? You might want to consider at least
diagramming your current workflow, at a conceptual level, as you assess it.
This step will help you as you begin your transition from Land Desktop to
Civil 3D.

An important aspect to consider is how or whether your organization utilizes
IT or CAD management resources. For example, in your organization, do you
have specific individuals who are responsible for installing and maintaining
tools and software? Do you have one or more individuals responsible for
maintaining your company’s drawing standards?

This is an important aspect to consider because, depending on the size and
complexity of your organization, you may need to schedule IT and/or CAD
management resources during the Civil 3D implementation phase.

Choosing Pilot Projects

The next step is to determine which project or projects in your organization
are the best ones to use as pilot projects. Choosing a pilot project that has the
following characteristics will help make the process of learning to use Civil
3D go smoothly. It may be best to choose a project that

B has a straightforward design that your company is familiar with

B has a flexible and willing client—if you choose billable projects

W is a smaller job

In other words, a large master-planned community for a new client, in a

location your organization is not familiar with, is probably not the best project
to use as your first Civil 3D pilot project.

There are two general approaches to consider when deciding how to implement
your pilot projects: using completed Land Desktop projects, and starting new
projects from scratch. The first approach, using completed Land Desktop
projects and recreating them using Civil 3D, can provide you with the
following benefits:

B The timeline for the pilot project is not tied to a client deadline or
milestone; in other words, the end date is open-ended.

B Encountering any unforeseen problems during this pilot effort has no
impact on client-related deliverables.
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B There are no budgetary constraints other than accounting for the
non-billable time spent training.

B There is less pressure on team members.

However, there are some drawbacks to consider when using existing Land
Desktop projects as a pilot projects:

B Without a timeline and the rush of client demands, many people find it
hard to work effectively and with their usual level of detail.

B Because you are not creating a design from scratch, but rather re-creating
an existing design, some portions of the design process might not be fully
explored using this type of pilot, leading to a false sense of security.

B Using existing Land Desktop projects does not allow you to gather
real-world metrics on design and production timelines for measuring the
success of Civil 3D in a real-world project environment.

When you use the second approach—starting a new project from scratch in
Civil 3D—the experience presents a broader spectrum of real-world issues and
scenarios. A real-world billable project will allow you and your team to learn
how to better deal with the actual design process, plan production, change
orders, and plan reviews.

Dispersing Knowledge

Your pilot projects will lead the way in how you train others in your
organization to use Civil 3D as a design platform. The following are some
different methods to consider for dispersing the knowledge gained from
working on pilot projects:

Rotating Pilots—Using this method, each design team is trained one at a time,
with one group following another. This allows a group of individuals to be
trained on an entire project in Civil 3D before moving on to train the next
group of individuals. It is highly recommended that each design team complete
a basic level of Civil 3D training before they begin a pilot project. Using this
method typically means training to various levels, and covering the full extent
of the product in every pilot project since each team will be new to Civil 3D
for each one. This process can be expensive because expert-level trainers would
be used for each team. However, with this method, because each group except
the first one will have coworkers that can provide guidance to others, the
learning curve for each subsequent group should lessen.
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Shared Knowledge Pilots—Using this method, the initial project team consists
of individuals who have already completed basic Civil 3D training, and who
are using a pilot project as advanced training. This team completes the first
pilot project, developing standards, styles, operating practices, and templates
along the way. After this project is complete, this group disseminates
knowledge to the next group. These team members then become responsible
for teaching the basics to the next generation of users, honing their own skills
in the process. This method can be less expensive than rotating pilots, but
can also result in a slower adoption rate, and a higher risk that individuals
may not be learning all of the best practices and techniques that they could
be learning.

Hybrid Pilot—This method combines some characteristics of the previous two
methods. A hybrid pilot methodology typically includes basic training for an
initial group of individuals from an expert-level, third-party trainer. This team
completes a pilot project, working in tandem with a trainer to build styles
and standards in preparation for more widespread Civil 3D deployment. After
this first pilot project is complete, these individuals are then used with the
expert as a training core, rotating through remaining teams and acting as
mentors for peers.

With this approach, the first generation of individuals learns how to use the
product while having the trainer immediately available for assistance if needed.
Because this method allows local users to be more involved in the training of
the next generation of users, more customization based on skill levels is
possible.

By reviewing your goals for implementation speed and cost, you can decide
on a pilot and training methodology and begin detailed planning for your
user-based training.

Understanding Training Resources

Whether it’s time spent learning how to use the product on your own, or time
spent attending an offsite or onsite training class, make sure that your pilot
project strategy includes the appropriate amount of time for individuals to
learn how to use the Civil 3D software.

The following sections describe a variety of training resources that are available
for learning how to use Civil 3D. They include:

m Civil 3D product documentation

B Autodesk training programs and products
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B Autodesk website

B Third-party resources

Civil 3D Product Documentation

You've already taken the first step by reading this book. After reading this
book, you should peruse the other documentation components available with
Civil 3D. They provide both the information you need to get started using
the software and complete descriptions of all Civil 3D features.

The following is a list of the Civil 3D product documentation components
that are automatically available when you install Civil 3D. These components
are accessible from the product’s Help menu:

Getting Started guide

Tutorials

Help system (User’s Guide)

Moving from Land Desktop to Civil 3D (this guide)

Best Practices Guide

New Features Workshop

TIP For any of the documentation components that are provided in PDF format,
you can print out all, or a range of, pages. For example, to print out the entire
AutoCAD Civil 3D User’s Guide, or sections of it, click the Help menu » User’s
Guide (PDF). Then use Adobe Reader’s printing features.

Getting Started—This guide introduces the most important concepts in Civil
3D. After reading through it, and perhaps completing some of the suggested
exercises using the sample files, you should feel comfortable enough to start
experimenting on your own. In addition to being available from within the
product, this guide is also available as a PDF download from the Autodesk
website. You also receive one free printed hardcopy with each Civil 3D license
purchase by going to the Autodesk book request
site—http://autodeskbookrequest.com/autodesk. Additional printed copies can be
ordered from the Autodesk Store at www.autodesk.com/store.

Online Tutorials—The tutorials offer an in-depth guided tour of the major
features, using realistic engineering drawings and data. To gain a thorough
knowledge of Civil 3D, it is recommended that you explore the tutorials after
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you have read through the conceptual information provided by the Getting
Started guide.

Help System—The Civil 3D Help system is a compiled HTML Help system that
provides comprehensive information about all Civil 3D features. It is available
by clicking Help menu » Help » AutoCAD Civil 3D Help. A PDF version
of the Help system, referred to as the User’s Guide, is available by clicking
Help menu » User’s Guide (PDF).

Best Practices Guide—This guide presents best practices for implementing
AutoCAD Civil 3D and using it efficiently in design operations. It is designed
to help you optimize your use of AutoCAD Civil 3D. Just like the Getting
Started guide, this book is available from the product Help menu, and a free
printed hardcopy is available with each Civil 3D license purchase.

New Features Workshop—The New Features Workshop provides a graphical
preview of features that are new with each version of the product. It includes
descriptions of AutoCAD and Map 3D features in addition to new Civil 3D
features. If you are moving from one version of the product to another, this
is a useful tool for quickly understanding what’s new in the product. If
everything is new to you, it is still a great way to get a quick overview of certain
features. It is available by clicking Help menu » New Features Workshop.

Autodesk Training Programs and Products

As you transition from Land Desktop to Civil 3D, you may want to invest in
some level of formal Autodesk training. Autodesk training programs and
products help you learn the key technical features of your Autodesk software
quickly. For the latest information about Autodesk training, visit
www.autodesk.com/training or contact your local Autodesk representative. The
following sections describe the various Autodesk training programs and
products that are available.

Autodesk Authorized Training Centers—To be more productive with Autodesk
software, consider getting trained at an Autodesk Authorized Training Center
(ATC®). These hands-on, instructor-led classes help you get the most from
your Autodesk products. Enhance your productivity with proven training
from over 1,400 ATC sites in more than 75 countries. For more information
about Autodesk Authorized Training Centers, contact atc.program@autodesk.com
or visit the online ATC locator at www.autodesk.com/atc.

Autodesk Official Training Courseware—Autodesk Official Training Courseware
(AOTC) is technical training material developed by Autodesk. The modules
are designed for 1/2-day to 5-day instructor-led classroom training. They are
typically used by Authorized Training Centers and other Autodesk partners,
but these materials are also well-suited for self-paced, stand-alone learning.
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The manuals cover key concepts and software functionality with hands-on,
step-by-step, real-world exercises. You can purchase AOTC “Essentials”
courseware from your local Autodesk representative or distributor, or you can
order it online from the Training Tools section of the Autodesk Store at
www.autodesk.com/store.

e-Learning—Autodesk e-Learning for Autodesk Subscription customers features
interactive lessons organized into product catalogs. Each lesson is 20 to 40
minutes in length and features hands-on exercises, with an option to use
either a simulation or the software application. You can also use an online
evaluation tool that identifies gaps in skills, determines which lessons will be
most helpful, and gauges learning progress.

If you are a member of Autodesk Subscription, you can access e-Learning and
other subscription services from within your Autodesk product. For more
information about Autodesk subscription resources, visit
www.autodesk.com/subscription.

Autodesk Website

A wealth of other resources are available from the Autodesk website. For
example, you may want to check out the Civil Engineering Community portal,
Skill Builder tutorials, current white papers, or webcasts, just to name a few.
Also, a variety of useful items are frequently updated and posted on the
Autodesk Civil 3D website.

Civil Engineering Community Portal—Become a member of the Autodesk Civil
Engineering Community to stay current with your industry, grow your
professional network, and take advantage of a host of resources. Benefits of
membership include access to Civil 3D content sharing, member discussions,
blogs, local events, webcasts, and user-submitted tips and tricks. You are sure
to hear from other Land Desktop users who have already moved or are in the
process of moving to Civil 3D. To access the portal, visit
www.autodesk.com/civilcommunity.

Skill Builders—Civil 3D Skill Builders are advanced learning exercises you use
to practice performing specific design tasks using Civil 3D drawings. To
download Civil 3D Skill Builders, visit www.autodesk.com/civil3d-skillbuilders.

White Papers—A variety of white papers on targeted industry-driven topics
are available from the Autodesk Civil 3D website. You can get in-depth
technical information, competitive briefings, and valuable return on
investment (ROI) analyses. To download Civil 3D white papers, visit
www.autodesk.comy/civil-whitepapers.
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Civil 3D Webcasts—The Civil 3D product management and development
teams host live webcasts featuring a variety of topics. This is a unique
opportunity to interact with the experts and gain valuable product knowledge.
From basic “Getting Started” sessions to advanced corridor modeling tasks,
there is something for every type of user and skill level. The webcast sessions
are recorded and are available on-demand via download. In particular, you
may be interested to view the Chronicles of Civil 3D webcasts. This series of
recorded sessions chronicles in real time the experiences of a Maine-based
civil engineering firm implementing their first Civil 3D pilot project. It provides
an inside look at how a small-town engineering firm, well accustomed to using
Land Desktop, used Civil 3D for the first time to generate designs plans on a
billable subdivision project.

To access recorded versions of the Chronicles of Civil 3D and other Civil 3D
webcasts, visit www.autodesk.com/civil3dwebcasts.

Third-Party Resources

You may also want to research third-party books and learning materials that
are available from a variety of sources.
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Comparing Land
Desktop and Civil 3D

Maybe you knew how to do something in Land Desktop, but you need to find out how to
perform the same function using Civil 3D. Where do you look in Civil 3D to find features
that were familiar to you in Land Desktop? This chapter presents a variety of information
that will help you quickly learn how to discover features and accomplish tasks in Civil 3D.
It compares terminology, user interfaces, and some of the most commonly used features in
both products.

Comparing Terminology

This section provides a list of terms that are common in the Land Desktop
product and identifies the corresponding terminology that is used in the Civil
3D product.

For some features, the difference in terminology is subtle. For example, in Land
Desktop a group of connected pipes is referred to as a “pipe run”, but in Civil
3D they are referred to as a “pipe network” on Civil 3D menus, toolbars, dialog
boxes, and in Civil 3D drawings.

For other features, the difference in terminology is quite distinct, indicating
that there is more than just a difference in terminology. For example, in Land
Desktop, you manage point groups using the Point Group Manager. In Civil
3D, you manage point groups using the Point Groups collection on the
Prospector tab in Toolspace. Using the Toolspace Prospector is a completely
different way of working with features that brings consistency across a number
of tools.

Refer to the following tables to help you become familiar with terminology in
Civil 3D. These tables may be handy references for you until your transition to
Civil 3D is complete.



General

The following table compares the differences in terminology between some
general features in Land Desktop and the corresponding features in Civil 3D:

Land Desktop Civil 3D
User Preferences Drawing template
Prototype Settings Toolspace Settings tab

Drawing Settings

Drawing Setup Drawing Settings

Quick Section Profiles menu » Quick Profile

3D Polyline commands Feature Line tools

Reports/File Output Report Manager

List values Inquiry Tool or Inquiry toolbar
Alignments

The following table compares the differences in terminology between
alignment features in Land Desktop and Civil 3D:

Land Desktop Civil 3D

Define From Obijects
Define From Polyline

Create By Layout
Create From Polyline

Alignment Labels
Station Labels

Alignment Label Styles
W Station

Station Offset

[ |

B Line
W Curve
|

Spiral
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Land Desktop Civil 3D

B Tangent Intersection

Edit Alignment Layout Toolbar

Cross Sections (Road Design)

The following table compares the differences in terminology between cross
section (road design) features in Land Desktop and Civil 3D:

Land Desktop Civil 3D

Draw Template Create Assembly
B Subassemblies — From Catalog

B Subassemblies — From Polyline

Design Control Corridor Model Properties
W Parameters

B Targets

Assembly Properties

View/Edit Sections View/Edit Corridor Section

Ditches/Transitions Alignments/Profiles
Subassembly logic
Corridor Model Properties — Targets

Sample Existing Ground Create Sample Lines
Section Plot Settings Sample Line Group Properties
Section Plot Create Views (Section)

B Single

Cross Sections (Road Design) | 19



Land Desktop Civil 3D

H  Multiple

List Section Data Inquiry Tool » Section View
Inquiry Tool » Section

Label Sections Section Label Styles
Section View Styles
Section View Band Styles
Section View Labels

Total Volume Output Quantity Takeoffs

Surface Volume Output Composite Volumes Panorama utility
Volume Surface

Road Output Corridor Model Surface

Grading

The following table compares the differences in terminology between grading
features in Land Desktop and Civil 3D:

Land Desktop Civil 3D

Grading Wizard Grading Creation Tools
Footprint Feature Line

Targets and Slopes, Daylighting Grading Criteria
Appearance Grading Style

Grading Properties Grading Editor

Grading Properties
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Inquiry

Land Desktop

Civil 3D

Create Surface

Automatic Surface Creation
(Grading Group property)

Calculate Volume, Balance Volume

Grading Volume Tools

The following table compares the differences in terminology between inquiry

features in Land Desktop and Civil 3D:

Land Desktop

Civil 3D

North/East
Lat/Long
Geodetic Inverse

Inquiry Tool » Point » Point Inverse

Station Offset — Alignment

Inquiry Tool » Alignment » Alignment
Station and Offset at Point

Line/Curve/Spiral

Object Properties

Roadway Curves
Railway Curves

Alignment Layout Toolbar » Sub-Entity
Editor » Alignment Grid View

Spiral Radius
Angles Inquiry toolbar » Angle Information
Distance Inquiry toolbar » Continuous Distance

Inquiry toolbar » Add Distance
Inquiry toolbar » Distance

Area by Lines/Curves, Polylines, or Points

Inquiry toolbar » Area

Inquiry toolbar » Line and Arc Informa-
tion

Inquiry toolbar » Locate Point
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Land Desktop Civil 3D

Contour/Surface Elevation Inquiry Tool » Surface

List Slope/Elevation at Slope Inquiry Tool » Surface
Inquiry toolbar » List Slope

Track North/East, Track Elevation Coordinate Tracker

Parcels

The following table compares the differences in terminology between parcel
features in Land Desktop and Civil 3D:

Land Desktop Civil 3D

Parcel Settings Parcel Layout Tools Toolbar
Parcel Styles
Parcel Label Styles

Parcel Manager List View on the Toolspace Prospector tab
Parcel Properties

Define from Lines/Curves (or Polylines) Create From Objects
Define from Parcel Layout Tools Toolbar
B Points Transparent Commands

B Slide Bearing
B Radial

B Swing Line
|

Swing On Curve
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Pipes

The following table compares the differences in terminology between pipe

features in Land Desktop and Civil 3D:

Land Desktop

Civil 3D

Settings Pipe Command Settings
Parts List

Pipe Run Pipe Network

Pipe Pipe

Node Structure

Pipe Run Editor

List View in Toolspace (Panorama) View

Edit Graphical

Grip edit

Edit Data

Pipe Editor
Structure Editor

Finish Draft Plan

Create Pipe Network

Finish Draft Profile

Draw Parts in Profile View

Finish Draft Section

Sample Pipe Network (Sample Line
Group)

Import/Export Runs

Import LandXML
Export LandXML

Align/Run Interferences

Create Interference Check
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Plan Production

The following table compares the differences in terminology between plan
production features in Land Desktop and Civil 3D:

Land Desktop Civil 3D

Sheet Creation Plan Production
General menu » Plan Production Tools
» Create Sheets wizard

Sheet Manager Plan Production Tools
General menu » Plan Production Tools
» Create View Frames wizard
General menu » Plan Production Tools
» Create Sheets wizard

Sheet Series View Frame Group

Frame View Frame

Create\Edit Frame Create View Frames wizard

Match Line Match Line

Generate Sheets Create Sheets (Create Sheets wizard)

Points

The following table compares the differences in terminology between point
features in Land Desktop and Civil 3D:

Land Desktop Civil 3D
Point Settings Toolspace Settings tab, Point Command
Settings
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Profiles

Land Desktop

Civil 3D

Point Group Manager

Toolspace Prospector tab, Point Groups
collection

XDRef Manager

Toolspace Settings tab » Point » Ex-
ternal Data References

Create Points (all commands)

Points menu » Create Points

List Points

Toolspace Prospector tab » List View
Panorama Point Editor

The following table compares the differences in terminology between profile

features in Land Desktop and Civil 3D:

Land Desktop Civil 3D
Profile (grid only) Profile View
Vertical Alignment, Existing Grade Profile

Profile Settings

Profile Command Settings

Set Current Surface
Toggle Multiple Surfaces
Select Multiple Surfaces

Create Profile From Surface dialog box

Sample Existing Ground — Sample from
Surface

Create Profile From Surface dialog box

Sample Existing Ground — Sample from
File

Create Profile From Surface dialog box

Create Full or Surface Profile

Create Profile From Surface
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Land Desktop Civil 3D

Create Profile Create View
W Grid
Create Profile Quick Profile

B Quick Profile

Define Vertical, Ditch, and Transition Create By Layout (Profile Layout Toolbar)
Alignments

Edit Vertical, Ditch, and Transition Align-  Edit Profile Geometry (Profile Layout
ments Toolbar)

Survey

The following table compares the differences in terminology between survey
features in Land Desktop and Civil 3D:

Land Desktop Civil 3D

Data Collection Input Survey tab in Toolspace

Analysis Figures Survey tab in Toolspace

Least Square Settings Survey Database Settings

Survey Command Line Survey Command Window

Equipment Settings Equipment Databases and Equipment
Properties

Figure Prefix Library Figure Prefix Databases and Figure Prefix
Properties

Astronomic Azimuth Astronomic Direction Calculator
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Terrain (Surfaces)

The following table compares the differences in terminology between terrain
(or surfaces) features in Land Desktop and Civil 3D:

Land Desktop

Civil 3D

Terrain menu

Surfaces menu

Terrain Model Explorer

Toolspace Prospector tab » Surfaces
collection

Edit Surface

Surfaces menu » Edit Surface

Surface Display

Surface Style

Contour Style Manager

Surface Style » Contours tab

Contour Labels

Surfaces menu » Add Surface Labels

Composite Volumes

Composite Volumes Panorama utility
Volume Surface, TIN Volume Surface

Utilities

The following table compares the differences in terminology between features
related to various utilities in Land Desktop and the corresponding features in

Civil 3D:

Land Desktop

Civil 3D

Object Viewer

General menu » Utilities » Object
Viewer

Notes

General menu » Utilities » Notes
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Land Desktop Civil 3D

Symbol Manager Toolspace Settings tab » Points »
Point Styles

Curve Text General Curve Label Style

Leaders Included in all object label styles

Multi-View Blocks Insert menu » Multi-View Blocks

Blocks Insert menu » Blocks

Lists/Legends Object Table Styles

Also, in both Land Desktop and in Civil
3D, you can use the Map 3D Map Book
features to create legends on maps.

Camera View menu » Create Camera

Comparing User Interfaces

This section compares the Land Desktop and Civil 3D user interfaces. It
provides an overview of some general differences in the user interfaces, and
includes a discussion about differences in workspaces and menus.

User Interfaces

Many aspects of the Land Desktop and Civil 3D user interfaces are identical.
Since both products are based on industry-leading AutoCAD software, Civil
3D still provides you with the familiar graphical work environment and
drafting tools you already know. For example, in Civil 3D, you'll notice
components like the top-level menu bar, toolbars, command line, drawing
area, and model and layout tabs you already know how to use.

One of the most noticeable differences between the two interfaces is the Civil
3D Toolspace window—a component that Land Desktop does not have.
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The Toolspace window is a concept that is totally new to Land Desktop users.
Using the three Toolspace window tabs, the Prospector, Settings, and Survey
tabs, you can control drawing objects and settings in ways that are not possible
with Land Desktop.
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For example, using the Prospector tab, you can quickly display a hierarchical
list of all objects in your drawing. [tems that exist as child objects to a parent
object, such as pipe and structure objects associated with a pipe network (pipe
run), can easily be displayed in the Prospector tab.

The Settings tab provides a powerful set of features for creating and managing
object styles, as well as for controlling default object behavior.
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Becoming familiar with how to use the Civil 3D Toolspace window is an
important step to Civil 3D proficiency. Once you understand how it works,
it’s very easy to use, and you will find many ways to increase your productivity.
To learn more about how to use the Civil 3D Toolspace, see The Toolspace
Window in the Civil 3D Help.

Workspaces

Just like Land Desktop, Civil 3D comes equipped with a variety of workspaces
that offer sets of tools commonly used for certain types of tasks. For example,
in Land Desktop you can select the Survey workspace which provides access
to tools and features commonly used while performing surveying tasks.

With both products you can create your own custom workspaces so that you
can have quick access to a specific set of features you may want. In addition
to displaying a top-level menu that contains only the features related to a
specific task, the workspaces automatically display toolbars, tool palettes, and
other user interface elements to make sure that all the features you need for
a specific task are at your fingertips.
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The following table lists the menus that are displayed in the top-level menu
bar for the Land Desktop 2009 workspaces:

Land Desktop Workspaces

Land Desktop Menus

Land Desktop

File, Edit, View, Tools, Map, Projects,
Points, Lines/Curves, Alignments, Parcels,
Labels, Terrain, Inquiry, Utilities, Window,
Help.

Land Desktop Complete

File, Edit, View, Insert, Format, Tools, Draw,
Dimension, Modify, Map, Projects, Points,
Lines/Curves, Alignments, Parcels, Labels,
Terrain, Inquiry, Utilities, Window, Help.

Civil Design File, Edit, View, Tools, Map, Projects,
Points, Terrain, Grading, Layout, Profiles,
Cross Sections, Hydrology, Pipes, Sheet
Manager, Inquiry, Utilities, Window, Help.

Survey File, Edit, View, Tools, Map, Projects,

Points, Terrain, Data Collection/Input,
Analysis/Figures, Inquiry, Utilities, Window,
Help.

The following table lists the menus that are displayed in the top-level menu

bar for the Civil 3D 2009 workspaces:

Civil 3D Workspaces

Civil 3D Menus

Civil 3D Complete

File, Edit, View, Insert, General, Survey,
Points, Surfaces, Lines/Curves, Parcels,
Grading, Alignments, Profiles, Corridors,
Sections, Pipes, Map, Express, Window,
Help.

Design

File, Edit, View, Insert, General, Points,
Surfaces, Lines/Curves, Parcels, Grading,
Alignments, Sections, Profiles, Corridors,
Pipes, Inquiry, Express, Window, Help.
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Civil 3D Workspaces

Civil 3D Menus

Annotation and Drafting

File, Edit, View, Insert, General, Annotation,
Inquiry, Window, Help, Express.

Survey and Topographical

File, Edit, View, Insert, General, Survey,
Points, Surfaces, Lines/Curves, Parcels,
Alignments, Inquiry, Map, Window, Help,
Express.

Visualization and Rendering

File, Edit, View, Insert, General, Window,
Help, Express.

To become more familiar with workspaces, including how to access them, edit
them, and create your own custom workspaces, refer to Create Task-Based
Workspaces in the AutoCAD Help.

Civil 3D Lines/Curves Menu

Civil 3D has a Lines/Curves menu that is modeled after the Land Desktop
Lines/Curves menu; however, it has a few additional features.

Create Curves 4

Create Best Fit Ertities 4

Attach Mulkiple Entities

Curve Calculator

Add Line/Curve Labels 4

Line by Paint # Range
Line by Point Ohject

Line by Paoink Mame

Line by Morthing/Easting
Line by Grid Morthing/Grid Easting
Line by Latitude/Longitude
Line by Bearing

Line by Azimuth

Line by Angle

Line by Deflection

Line by Stakion /O set
Line by Side shot

Line Extension

Line From End of Cbject
Line Tangent from Point

Line Perpendicular From Paint

For example, on the Civil 3D Lines/Curves menu, you have the Curve
Calculator, which is a tool you use to determine curve parameters based on
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input. It lets you calculate horizontal curve data and simultaneously interact
with active Civil 3D COGO commands as well as AutoCAD commands.

Curve Calculator o E]
Property Yalue Units
Degree of Curve Definition | Arc Definition v
Fixed Property [&rc Definition

Degree of Curve Chard Definition =/ degree decimal

Delta Angle 0.0000 {d) | i degree decimal
Radius 0.0000" | o Fioot
Tangent Distance 0,0000" | e Fook
Arc Distance 0.0000" | o Fct
Chord Distance 0.0000" | oo Fioot
External Distance 0,0000" | e Fook
Mid-ordinate Distance 0.0000" | o Fot

With this functionality, you can calculate horizontal curve properties based
on arc or chord definitions. You can select an arc object from the drawing
and display its curve properties in the Curve Calculator. Also, you can calculate
properties and send a curve property to the command line interface within a
current command, or send the properties to the Windows Clipboard to
cut-and-paste into another application.

Comparing Features

This section explores some of the more commonly used features that exist in
both Land Desktop and Civil 3D. It discusses the differences in methodologies
and workflows inherent in these features in both products. Understanding
the mechanics of how the features are different (for example, understanding
what the Civil 3D software is doing behind the scenes, what the menus and
dialog boxes look like, and what a typical Civil 3D workflow is like) will greatly
reduce the learning curve.

In this section, we’ll compare how the following features work in Land Desktop
and in Civil 3D: points, surfaces, alignments and profiles. An important item
to note as you read through this section is that many of the Civil 3D concepts
and behaviors you'll learn about exist in many areas of the product. This
section also illustrates how Civil 3D is much more consistent than Land
Desktop in the way that it allows you to manage features.
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Points

Experienced Land Desktop users will be happy to know that Civil 3D combines
several of the point functionality concepts from Land Desktop into an
easy-to-use Civil 3D point object. This section begins with a brief description
of how points work in Land Desktop.

Points in Land Desktop

The Land Desktop point concepts you are already familiar with include point
settings, point object, point symbology, point groups, and point labeling. The
following table provides a brief description of how each of these concepts is
implemented in Land Desktop:

Land Desktop Point Functionality Description

Point Settings When creating points in Land Desktop, first
you need to adjust Point Settings to
achieve desired output. These settings
control things like the starting Point Num-
ber, whether elevations are required, if
descriptions are visible, where to find
symbology, text size, and so on. All points
created after these Point Settings are estab-
lished adopt the current Point Settings and
are displayed accordingly. Points created
before the Point Settings are either estab-
lished or changed would remain as they
are.

Point Object Each point in Land Desktop is an individual
object and is part of an external points
database file (*.mdb).

Point Symbology For a point to represent something like a
fire hydrant, description keys can be used
to automatically insert a symbol (block) at
the point’s insertion point.
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Land Desktop Point Functionality Description

Point Labeling Point labels, usually combined with Point
Groups, let you quickly show point descrip-
tions on some points and not others, label
data, such as northing and easting, and
control settings, such as units, text height,
and layers used.

Even though point functionality in Land Desktop accomplishes the work you
need to do, and you are comfortable with it, it still has some limitations. For
example:

B Have you ever moved some points only to realize that your symbols did
not move with them?

B Have you ever wished you could use the Undo command after accidentally
moving or erasing some points?

B Have you ever wished there was a way to quickly change point sizes, with
just a few clicks, so they could be used in a 50 scale drawing instead of a
100 scale drawing?

B Have you ever wanted to create a Point Group by combining several other
Point Groups?

B Have you ever found it difficult to maintain standards so that points labeled
by one individual on your team look the same as points labeled by someone
else?

Points in Civil 3D

When you are working with points in Civil 3D, one of the first things that is
important to understand is that in Civil 3D, each point is maintained as an
individual object. Each point also always belongs to a point group, which is
also an object. This means that you can manage points at different hierarchical
levels. Being able to manage points this way improves overall performance
and provides additional flexibility that you do not have when using points
in Land Desktop.

A second concept that is important to understand is that unlike Land Desktop
points, the display characteristics of Civil 3D points are based on two style
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settings: the point style and the point label style. This is a concept that is
employed throughout many Civil 3D object types.

!

Point— L Point Label
Style Style

The point marker (shown as the “X” in the preceding illustration) is controlled
by the point style and the label text for the point is controlled by the point
label style. Setting up proper styles is one of the keys to unlocking the potential
of Civil 3D. By simply setting the point style to the desired marker, which can
include symbology, and setting the point label style to the desired label style,
you can achieve virtually limitless combinations for displaying points.

Note that in Civil 3D, when you are using symbology as part of your point
style, the symbol is the marker. In other words, there is no separate block
inserted on top of the point. Instead, the symbol is embedded in the point
itself. Because points are dynamic in Civil 3D, so are the symbols. For example,
there is no need to maintain multiple fire hydrant blocks to accommodate
plotting drawings at multiple scales. Also, symbols never become separated
from their associated points as they may have in Land Desktop. Your point
styles can be set in such a way that you can still control visibility of the
symbology, and the points still do what they did in Land Desktop. For example,
you can still show symbols and no points, or show points and no symbols,
or show neither. It is simply easier to do this in Civil 3D.

Civil 3D contains numerous styles you can begin working with right away,
including ones that look like Land Desktop styles. These styles can be assigned
to the points directly by selecting the point(s), and then right-clicking and
clicking Edit Points. Doing it this way is like switching from a BYLAYER setting
to a fixed setting.

You can also set these styles at the point group level, which means that all
points in that group are updated automatically. To do this, simply click on
the desired Point Group in the Project Toolspace (Prospector Tab), right-click,
and click Properties.

36 | Chapter 2 Comparing Land Desktop and Civil 3D



. Point Group Properties - Topo 10-25-07

Information  |Point Groups | Raw Desc Matching | Include | Exclude | Query Builder | Overrides || Point List | Surmmary
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Default skyles
Paint: style:
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Paint: label style:

‘@' Land Desktop Point Label Style v

[ object locked

[ OK ] [ Cancel ] [ Apply ] [ Help ]

Because you can associate a symbol with your points using the point style,
does this mean that description keys are not necessary in Civil 3D? This is
your decision. Description keys still exist and still function in Civil 3D similarly
to how they function in Land Desktop. The major difference is that instead
of inserting blocks, as you would in Land Desktop, in Civil 3D, they set the
desired point style and point label style for each point. With Civil 3D, you
can decide which method of handling point styles and symbology works best
for your situation.

7]
A o
Code Paint Style Point Label Style Format Layer %
TR STA [¥] Marthing and Easting §* ¥-CTRL-HCPT Y
28 SWMH Starm Sewer Manhole Elevation Crky §* Y-RIODE-55WR &
o TR Tree [+] Description Only §* Y-NODE-TREE é
-]
=
=
g
=
"
=Y
(S[E3 >
Aol Il

A third concept to understand when comparing Civil 3D and Land Desktop
point functionality is the fact that Civil 3D project data is drawing based rather
than project based as in Land Desktop. Because Civil 3D data is drawing based,
the points exist in your drawing file and do not point to an external point
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database, as they do in Land Desktop. This means that your points cannot
become out of sync with an external point database, so operations such as
the Undo command are no longer a problem. Without an external point
database, commands like Check Points and Insert Points To Drawing are no
longer necessary, as well.

Creating Points

The way that you create points in Civil 3D is very similar to how you created
points in Land Desktop. For example, you can use the CreatePoints command
or the individual commands from the Points menu. When you click Create
Points on the Points menu, the Create Points toolbar is displayed.

Create Points G E]
(#-] @&~ @- @¢. 5. @& @ ¥
C & v Manual
| ®| Geodstic Direction and Distance
Resection
# | Station/Offset Object
Iﬁ_ Aukornatic
*@" Along Line/Curve
ﬁ? On LinefCurve
4| Divide Object
'ﬁé;, Measure Cbiject
i“:—* Polyline Vertices - Manual
ri‘:—* Polyline Wertices - Automatic
Q‘;:_s Convert AubaCAD Painks
g@ Convert Softdesk Point Blocks

Under each button on the toolbar are various drop-down options for creating
points. These options should look familiar to Land Desktop users because
most of the methods are the same as in Land Desktop. Even the Import Points
dialog box in Civil 3D, shown in the following illustration, should look
familiar.
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So while some aspects of using points are very different in Civil 3D, much of
your Land Desktop knowledge is still directly transferable when you start using
Civil 3D.

Editing Points

Editing points in Civil 3D is also not that different from how you did it in
Land Desktop. For example, the following illustration shows the similarities
between the editing points in Civil 3D and Land Desktop.

The following illustration shows the Land Desktop Edit Points drop-down
menu:
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This illustration shows the Civil 3D Edit Points drop-down menu:

Foinks Surfaces i 'YES Parcels Grading Alignments

5"3‘5.& Create Paoinks...

Create Points - Miscellaneous 4 l“ ﬁ ™~ @
N

Create Poinks - Inbersections 4 :
Create Points - Alignments 4 ? E @ @ {if % {i} ip
Create Points - Surface 4

Create Points - Slope 4

Create Points - Interpolate 4

"':3’ Create Point Group...

Import/Export Points 4
List Points. ..
Edit Points 4 Points...
Paint Groups...
5 add Tables. .. P
. Daturm. ..
Utilities 4
Elevations from Surface. ..
Renurnber. ..

Even though the Civil 3D menu has fewer options than the Land Desktop
menu, this is a situation where less is more. In the Land Desktop menu, many
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of the Edit options are necessary because of the external point database in
Land Desktop. These special Point Edit commands are completely unnecessary
in Civil 3D. In other words, rather than having a special Rotate Points or Erase
Points command, in Civil 3D you can use standard AutoCAD commands to
do many of your edits.

Point Groups

As soon as you create your first point in Civil 3D, an “_All Points” group is
automatically created. All points in your drawing are contained in the All
Points group. As in Land Desktop, you can create as many additional groups
as you need.

While you are examining Civil 3D, note the Point Groups tab at the top of
the Point Group Properties dialog box. This tab lets you create a point group
using other point groups. For example, if you have a “Road CL Group”, a
“Road EOP Group”, and a “Road Curb Group”, you can create a new “Roadway
Group” using the other Road Groups. Perhaps you have a “Wednesday Group”
a “Thursday Group” and a “Friday Group” that contain points to be staked
on each day. You could create an overall “Stake Out Group” containing the
other three groups without having to spend more time trying to filter out
points from Wednesday, Thursday, and Friday.

Summary

Now that you've explored the differences between points in Land Desktop
and Civil 3D, let’s review how Civil 3D can provide you with a better solution
for working with points.

Land Desktop Limitation Civil 3D Solution

Have you ever moved some points only to  In Civil 3D, the symbol is part of the point
realize your symbols didn’t move with itself.
them?

Have you ever wished you could use the Civil 3D does not rely on an external point
Undo command after accidentally moving  database, so you can use the Undo com-
or erasing some points? mand during point operations.
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Land Desktop Limitation Civil 3D Solution

Have you ever wished there was a fast way ~ Because Civil 3D points are dynamic, they
to change your point sizes so they could will automatically adjust their size by

be used in a 50 scale drawing rather than  simply changing the drawing scale.

a 100 scale drawing?

Have you ever wanted to create a point Civil 3D point groups can be created from
group by combining several other point other point groups.
groups?

Have you ever found it difficult to maintain  Civil 3D uses templates with built-in styles
your organization’s CAD standards so that ~ to guarantee standards compliance.
points labeled by one person look the same

as points labeled by another person?

Surfaces

When you work with surfaces in Civil 3D, you will notice many differences
from Land Desktop right away. What is important to understand is that all
of the same functionality you had with surfaces in Land Desktop still exists
in Civil 3D. The functionality is just simplified, and in some cases, uses a
different methodology to accomplish the same result. The following section
provides a brief description of how surfaces work in Land Desktop.

Surfaces in Land Desktop

The Land Desktop concepts and tools that are built into the Civil 3D surface
object include the Terrain Model Explorer, Surface Editing, Contour Creation,
and the Contour Object. The following table briefly summarizes how these
features work in Land Desktop:

Land Desktop Surface Function- Description
ality

Terrain Model Explorer You create surfaces in Land Desktop using the
Terrain Model Explorer where you can select
data from sources such as point groups or
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Land Desktop Surface Function-
ality

Description

boundaries to build a surface. Once built, the
surface is written to an external file, which is
actually a folder of data under the Land Desktop
Project/DTM folder. Having the surface connec-
ted to this external file presents several of the
same issues you might have with points.

Surface Editing

If you want to edit your newly created surface,
you must first import 3D lines. This is because
the surface exists in an external file, and not in
the drawing. After importing the 3D lines, there
are numerous options available for performing
edits. For example, if you want to “flip face”,
you must do it one at a time. Furthermore, after
each flip, you must rebuild the surface, reimport
the contours, and possibly, re-label all the con-
tours. This type of workflow can result in design-
ers having to perform these tasks over and over
again.

Contour Creation

After you finish editing a surface, you must cre-
ate contours using yet another tool.

Contour Object

Each contour is a separate object with no asso-
ciation back to the original surface. Editing the
surface means you must recreate contours.

Building surfaces in Land Desktop involves many steps, and the process is not
very intuitive. Although the process lets you accomplish the work you need
to do, it does have several limitations. For example:

B Have you ever created a surface and wished there was some immediate
visual feedback to show what you created?

B Have you ever edited a surface and wished your contours would update

automatically?

B Have you ever wished you could use the standard Undo command to fix
a mistake you made to your surface?
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B Have you ever had to extensively edit a surface created from contours to
correct areas not interpolated correctly?

B Have you ever wished your contour labels could faithfully be used for
multiple scale drawings?

Surfaces in Civil 3D

In Civil 3D, you can create surfaces on the Prospector Tab in the Toolspace
window by right-clicking on the Surfaces collection, and clicking Create
Surface. Or you can also select the same command from the Surfaces menu.
A dialog box prompts you to assign the surface a name and a style. If you
don’t assign the surface a name, it is given a default name which is typically
Surface[1]. This default object naming is just one of the useful conventions
used in many Civil 3D features.

'2{? Create Surface...
Eﬁz Create Surface from DEM. ..
Create Surface from TIN...

Edit Surface . Create Surface
Add Surface Labels | Type: Surface layer:
E Add Legend Table...| | TIM surface | | c-Toro
Utilitizs Properties Yalue
El Information

Mame Surface <[Mext Counter{CPI]>

Description Descripkion

Style Standard

Render Material BwLayer

\ !g Selecting OK will create a new surface which will appear in the lisk of surfaces in Prospectar,

[ (o4 ] [ Cancel ] [ Help ]

Z

After supplying a name for the surface and clicking OK, the new surface object
is displayed in the Prospector tree. Similar to the Land Desktop Terrain Model
Explorer, you can expand the + symbol next to the newly created surface to
view the items beneath it and assign the data you want to use to build the
surface. You'll notice that the list of available data types contains primarily
the same types that are available in Land Desktop.

44 | Chapter 2 Comparing Land Desktop and Civil 3D



o E TR oo @

v

=

| Active Drawing tiew

¥
Prospector

= ™ Pipe Networks-3
% Points
& Point Groups
= @ surfaces
27 Corridor - (1) Surface - (2)
o ®" [
B Masks
& watersheds
= & f@ ¥ Definition
i Boundaries
& Breaklines
il Contours
DEM Flles =
{7 Drawing Objects
@ Edits
Paint Files
& Poirt Groups
" ROADI_SURF
2 fhgnments [v]

]

Settings

Survey

= Toolspace

By right-clicking on a data type (such as Contours, for example) and adding
the necessary data, the surface is automatically built and displayed in model
space according to the style settings.
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The process of building a surface from contour data in Civil 3D produces far
superior results than what can be created with Land Desktop. For example,
in Civil 3D, if you display contours on a newly created surface that was created
from contour data, the contours will match the original. This is a significant
improvement over the surface capabilities in Land Desktop.

Another aspect of Civil 3D surfaces that is important to understand is the
surface style. In Civil 3D, the surface is the object, and the contours are subsets
of that object. This is another area where the capabilities of Civil 3D far exceed
Land Desktop. Because the contours are a subset of the surface, by simply
changing the surface style you can present the surface in a wide variety of
ways. For example, you can show contours at different intervals, with slope
arrows, elevation banding, and more. Showing contours at 1’ and 5’ intervals
after they were originally displayed at 2’ and 10’ intervals is as simple as a few
clicks. The same is true for displaying components like elevation banding.
Performing a similar task in Land Desktop would take many minutes as
opposed to just a few seconds in Civil 3D. To display a particular subset of the
surface, you need only turn it on in the Display tab for the surface style. To
configure a specific subset like contours, simply click on the appropriate tab
and set the values as desired.

13 Surface Style - Contours 1" and 5° (Design)

Information ||Borders | Contours | Grid Points | Triangles | ‘Watersheds | Analysis
Wigw Direction:
Plan v
Component display:
Compane. .. Visible Layer Color Linetype LT Scale Lineweight Flot Style
Painks ',} C-TINM MEYLAYER  Bylayer 1.0000 ByLayer
Triangles @ C-TINM-VIEW  BBYLAYER  Bylayer 1.0000 ByLayer
Border o C-TINM-BMDY  [EBYLAYER  Bylayer 1.0000 ByLayer
Major Cantour ) C-TOPO-MAIR. CBYLAYER  Bylayer 1.0000 ByLayer
Minor Contaur 1) C-TOPO-MINR. [EBYLAYER  Bylayer 1.0000 ByLayer
User Contours ) C-TOPO-USER. [CBYLAYER  Bylayer 1.0000 ByLayer
Gridded ] C-TIMNM MEYLAYER  Bylayer 1.0000 ByLayer
Directions @ | 1.0000 ByLayer
Elevations ] | 1.0000 ByLaver
Slopes @ | 1.0000 ByLayer
Slope Arrows ',} | 1.0000 ByLayer
watersheds ) C-TOPO-wSHD MIBYLAYER  Bylaver 1.0000 ByLayer
[ OF ] [ Cancel ] [ Apply ] [ Help ]

Civil 3D includes drawing templates that contain numerous predefined surface
styles you can choose from or use as a starting point for creating your own.
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Surface Editing

To edit a surface, you can set up the surface style to display both triangles and
points. You might even want to consider creating a style specifically for editing.

In Civil 3D, all Surface Edit functions are conveniently located either from
the Surfaces collection in the Prospector tree, or from the Surfaces drop-down
menu in the top-level menu bar. These options should look familiar to Land
Desktop users. If you compare the Land Desktop Edit Surface drop-down menu
to the Edit Surface menu in Civil 3D—with the exception of Flip Face being
renamed to Swap Edge—you’ll notice that they are virtually identical.

The following illustration shows the Land Desktop Edit Surfaces drop-down
menu:

3 Terrain Model Explorer...
‘ Set Currenk Surface., ..
Iﬁ Save Current surface

Edit Surface 4 @ Import 30 Lines
Surface Border Y & addLine
Surface Display 4 E‘H Delete Line
Surface Ukilities 4l <& Flip Face
Contour Style Manager.. . .l;g Add Paint
@ Create Contours. .. .I;-i Delete Poink
Contour Labels ¥ 4 Edit Point

Contour Utilties 4 . )
% Mondestructive Breaklines

3D Palylines 4 EJ? Minimize Flat Faces

N 3/ RaisefLower Surface

® paste Surface...

& select Current Stratum. . & surface Boundaries
Site Definition

Sections

Grid Wolumnes
Composite Yolumes

Section Yolumes

* v v v

Volume Reports

Terrain Layers 4

The following illustration shows the Civil 3D Edit Surface drop-down menu:
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Delete Paink
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Paste Surface. ..
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Because a Civil 3D surface is not connected to an external data file, many
steps that were required in Land Desktop become unnecessary, such as using
commands like Import 3D Lines, Create Contours, Build Surface, and Quick
View. Also, other commands become a lot simpler to use—for example, Undo,
Redo, Move, and Rotate. Have you ever wished that you could simply Undo
an errant surface edit? With Civil 3D, you can.

Because the surface object is the only representation of the surface data, you
no longer have to worry about whether the surface displayed in your drawing
actually matches the surface in your data file. For example, with Land Desktop,
you sometimes had to worry that someone might modify the contours
displayed on the screen, and as a result, the surface might not match the
surface file currently being staked in the field. By maintaining a single surface
object, the process of creating and editing a surface is simpler, and the chances
of errors are reduced.

Like Civil 3D points, surfaces can also be dynamic. By simply modifying the
underlying data used to create the surface, the surface is updated automatically.
For example, in Civil 3D, if you move a point or grip edit a boundary, the
surface is updated. Unlike the static methodology used in Land Desktop, using
the dynamic model-based design in Civil 3D, you can automatically roll
forward any changes made to your data.
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Labeling Contours

Labeling contours in Civil 3D is similar to labeling contours in Land Desktop.
Actually, the process is similar but the end result is different. Basically you
drape a Contour Label Line across multiple contours. This is the same as using
Label Group Interior in Land Desktop. Everywhere a contour intersects the
Contour Label Line, a contour label appears. The contour labels themselves
remain on the Contour Label Line and not on the contour itself. If you drag
the label line to different locations, the labels move with it. If you alter contour
intervals, for example, and if the new contours intersect the label line, they
are automatically labeled. This new contour behavior in Civil 3D may take
some practice to get used to, but the time savings of being able to make minor
to extensive changes to your surface without having to constantly re-label the
contours is substantial. You access the contour labeling features by selecting
Surfaces menu » Add Surface Labels, and then clicking Contour - Single,
Contour - Multiple, or Contour - Multiple At Interval.

After selecting a contour labeling command, you are prompted to pick two
points in model space. The line defined by these points becomes your Contour
Label Line. Like everything else in Civil 3D, contour labels are controlled by
styles. By modifying these styles, you can adjust the label look-and-feel to
match your particular organization’s requirements.

Calculating Earthwork

In Land Desktop, the process of calculating earthwork is complicated to say
the least. For example, as a minimum it can involve creating a stratum, defining
a site, having to understand the difference between grid, section, and
composite, and so on. Furthermore, many designers find that they do not
perform earthwork functions very frequently, which can make the task even
more difficult. Fortunately, Civil 3D makes the process of calculating earthwork
simple.

All you need are two surfaces and you can begin the process of calculating
earthwork by clicking Surfaces menu » Utilities » Volumes.
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You can still perform an earthwork calculation using multiple methods, as in
Land Desktop. The two possible methods are Grid and Composite. You can
perform these types of calculations just as easily in Civil 3D as in Land Desktop.
It is no more difficult than creating a new Volume surface. These types of
surfaces (Grid Volume Surface and TIN Volume Surface) are created using the
same tool as a regular surface. Rather than specifying components like Point
Group and Contour Data as data types to build the surface, you need only
select two surfaces to compare.
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. Create Surface

Type: . Surface layer:
TIM surface w | | C-TORO
TIM surface
Grid surface value
Grid volume surface
TIM volume surface
Tame Surface <[Mext Counter{CP)]>
Drescription Drescription
Skyle Standard
Render Material ByLaver

5\ !% Selecting OK will create a new surface which will appear in the lisk of surfaces in Prospector.

[ (o] 4 l [ Cancel ] [ Help ]
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As a result of performing a calculation this way, you have the added benefit
of creating a surface that can be used to display cut and fill contours or
elevation banding to validate earthwork numbers.

The following illustration shows an example of a surface style being used to
display earthwork cut and fill data by using elevation banding. Colors can be
used to indicate cut and fill areas. For example, a color such as dark red could
be used to indicate deepest cut, and dark blue could be used to indicate highest

fill. Civil 3D can also automatically prepare and insert a legend to define the
coloring.
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Summary

Although working with surfaces in Civil 3D is very different from working
with surfaces in Land Desktop, there are many benefits. From creation to
completion, working with surfaces in Civil 3D is more intuitive, requires fewer
steps, and helps eliminate the possibility of error. The following table provides
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a quick review of how Civil 3D solves many of the issues you may have had

when working with surfaces in Land Desktop:

Land Desktop Limitation

Civil 3D Solution

Have you ever created a surface and
wished there was some immediate visual
feedback to show what you created?

Civil 3D uses surface styles to display your
surface from the minute you add your first
piece of data to it.

Have you ever edited a surface and wished
your contours would update automatically?

In Civil 3D, the contours are a subset of
the main surface object. Editing the surface
automatically updates your contours.

Have you ever wished you could use the
standard Undo command to fix a mistake
you made to your surface?

Because Civil 3D surfaces are not connec-
ted to an external data file, using com-
mands like Undo is not a problem.

Have you ever had to extensively edit a
surface created from contours to “fix” areas
not interpolated correctly?

Creating surfaces from contour data in Civil
3D produces significantly more accurate
results, thereby reducing the need for ex-
tensive manual editing.

Have you ever wished your contour labels
could faithfully be used for multiple scale
drawings?

Civil 3D surfaces and labels are dynamic.

Changes to drawing scale and rotation will
automatically adjust label height and ori-
entation, even when the surface is an xref.

Alignments and Profiles

When you work with alignments and profiles in Civil 3D, you’ll notice many
differences from Land Desktop. Just as with other features, accomplishing
alignment and profile tasks in Civil 3D is easier and more powerful than in
Land Desktop. The following section provides a brief description of how you
worked with alignments and profiles in Land Desktop.
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Alignments and Profiles in Land Desktop

As with other Land Desktop features, working with alignments and profiles
in Land Desktop involves working with, and having to maintain, data in
external files or databases.

Land Desktop Functionality Description

Alignment Creation Create alignments from objects or polylines by select-
ing the desired entity, selecting a reference point,
and then giving the new alignment a name and sta-
tion information. If you are creating from a polyline,
you had to guess if it was originally drawn in the
direction you need. Once defined, the alignment is
created in an external alignment database.

Station Label Settings At some point you must establish station label set-
tings by clicking Alignments menu » Station Label
Settings. Make choices in the Alignments Station
Label Settings dialog box.

Station Label Creation Once station label settings are established, create
the labels by clicking Alignments menu » Create
Station Labels. A prompt asks if you want to delete
the old station labels and replace them with the new
ones. (Many users have noted that at this point in
the workflow, it’s a little too easy to inadvertently
delete all the station labels for all your alignments.)

Profile Settings Before creating a profile, verify that the profile set-
tings are as desired. These settings control compon-
ents like sampling, layers, and labels.

Profile Creation First set the desired surface and alignment as current,
then you can create a Profile from a Surface, from a
File, or from Sections. A command line message in-
dicates when the profile is created. The profile data
is maintained in an external data file. To view the
profile, select Profile menu » Create Profile. After
making choices in the Profile Generator dialog box
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Land Desktop Functionality Description

and picking a point in the drawing, the profile is
displayed. Moving it, however, can cause problems.

Vertical Alignment Editing If you would like to add a proposed (finished ground)
profile, you have two options. You can generate the
proposed profile graphically (using several tools) or
you can use the Vertical Alignment Editor. Both op-
tions are available on the Profile menu. If you want
to add the proposed profile, complete with labels,
to the existing profile, use the Import utility.

Most Land Desktop users are comfortable working with the alignment and
profile functionality because it is a process they already know. It does however,
have some limitations. For example:

B Have you ever had to reverse the direction of an alignment?
B Have you ever wished you could rename an alignment?

B Have you ever edited alignment geometry and then realized that you now
have to recreate the profile?

B Have you ever had to rework a drawing because someone moved your
profile?

B Have you ever wished you could create more than one finished grade
profile for an alignment?

Alignments and Profiles in Civil 3D

In Civil 3D, one of the most significant differences in working with alignments
and profiles is that the alignment and profile data exists in the drawing file,

not in an external database or file. There are several other significant differences
too, such as the fact that Civil 3D alignments and profiles are dynamic objects.

Alignments

Just as in Land Desktop, in Civil 3D you can create alignments in a few
different ways. From the Alignments menu, you can choose to Create
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Alignment By Layout, or Create Alignment From Polyline. There is no “Define
From Objects” option on this drop-down menu, but you can create alignments
in a variety of shapes, using precision tools to perfect your geometry, by using
the Alignment Layout tools toolbar.

plignments | Profiles  Corridors

E:L‘Q Create Alignment by Layout...

Create Alignment from Polyline

Edit Alignrment Geametry. ..

Reverse Alignment Direction
Diesign Criteria Editar. ..

Add Alignment Labels 4
Add Tables 4

The process of creating an alignment from a polyline is nearly identical to
that same option in Land Desktop. Once the polyline is created, you select it
and then use the Alignments menu to convert it into an alignment (Alignments
menu » Create Alignment From Polyline).

You can also use the Create Alignment From Network Parts command, which
is available from the Pipes » Utilities menu. The Create Alignment From
Network Parts option is very similar to the Create Alignment From Polyline
command. Use it to quickly create an alignment from an existing pipe network
(pipe run) in your drawing.

Creating an alignment using the Layout tools is a new concept for Land
Desktop users. To access the Alignment Layout Tools toolbar, choose
Alignments menu » Create Alignment By Layout, or enter
CreateAlignmentLayout on the command line. When you do one of these,
the Alignment Layout Tools toolbar is displayed.

Alignment Layout Tools - Alignment - (1) G E]
A~ A | Sy Ay Ly e PrlA ||l DT 0 o
Select a command from the layout tools Spiral Type: Clothoid

Basically, you use this toolbar to construct alignments with specific engineering
rules or constraints built in. It provides you with a variety of options for
creating your alignment.

The advantage of creating your alignment using the Alignment Layout tools
is that you can incorporate design criteria directly into your alignment. For
example, you can create an alignment that requires that an arc must pass
through a particular point. Using this toolbar, you can create complex
geometry that would be challenging and time-consuming to construct in Land
Desktop.
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No matter which alignment creation method you use, you are eventually
prompted to enter some basic alignment object creation information, such
as name, description, style, layer, label set, and so on.

. Create Alignment - From Polyline

Hame:
Alignment - { <[Mext Counter(CP)]>) (d

Description:

Starting station: | 0++00,00°
General | Design Critetia

Site:

] i<Nones} v
Alignment style:

3 Design Style v
Alignment layer:

C-ROAD @
Alignment label set:

4 Standard v:

Conversion options
Add curves hetween tangents

Erase existing entities

[ OF H Cancel ][ Help ]

Another important concept to understand is that after it is created, the
alignment itself is an object. As such, by default it contains station labels.
Therefore, you no longer have to add them. Because in Civil 3D an alignment
object is not connected to an external database, you can edit your alignment
as often as necessary without having to go through any re-creation process.
For example, in Civil 3D, you can grip edit alignments, as well as all the labels,
curves, and bearing/distances associated with it. In Land Desktop, to do the
same requires that you update each of these individually.

Have you ever needed to change the length of an alignment part of the way
through a project? How about having to rename one? In Civil 3D, tasks like

this are no longer an issue. Also, you should note that there is a handy “Reverse
Alignment Direction” option.
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Alignments | Profiles  Corridors

':::':} Create alignment by Lavout. ..

Create Alignment Fram Polyline

Edit Alignment Geometry. .,

Reverse Alignment Direckion

Design Criteria Editor. ..

&dd Alignment Labels r
Add Tables r
Profiles

You'll find that the way you work with profiles in Civil 3D is dramatically
different from the way you worked with profiles in Land Desktop. In Civil
3D, a profile is simply a vertical representation of data from an alignment
(and a surface). In other words, a profile is more or less a linear object. In Civil
3D, the profile itself does not contain the grid lines, stationing information,
and elevations, as profiles do in Land Desktop. Instead, the grid lines,
stationing, and elevation data for a profile are stored in a separate, new object
type called a profile view. The profile view is simply a container to display
profiles. It maintains the data associated with the actual linear profile (the
profile object) item, such as the length, start and end points, and station and
elevation data of the alignment it represents. It also creates and controls the
actual grid in which you display the profile data, along with information such
as the bands of data you want to display along the X-axis above or below the
grid.

At first glance, this may seem complex, but this methodology actually makes
working with profiles easier. For example, using Land Desktop, have you ever
wanted to have more than one proposed profile for a single alignment, so
that you could show several options for a proposed road design? Land Desktop
only allows you one. Below is an example of this concept. It shows the Civil
3D Prospector tree with an alignment called Fescue Drive that contains four
profiles (one existing and three proposed).
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= *=F  Fescus Drive

= Il Profiles
ed”  Alteriate One
Ibed”  Alteriate Two
mN"  Existng Ground - Surface (3)
el Proposed Ground 1

=l Profile views
[ Fescue Drives

Below those profile entries are any profile views for Fescue Drive. In this case,
there is only one. If you want to compare your Existing Ground to Alternate
One, you can create a Profile View to display them together on the same grid.
If you would like to compare the Existing Ground to Alternate Two, you can
create a second Profile View to display those as well. There are really many
ways you could display this data.

Creating Profiles and Profile Views

Now that you have an understanding of profiles and profile views, let’s explore
how you create them in Civil 3D. This section explores creating an existing
and a proposed profile, and begins by using the Profiles menu.

For the most part, existing profiles are created using the Create Profile From
Surface command, and proposed profiles are created from the Create Profile
By Layout command.

Create Profile from Surface.. .
M Create Profile by Layout...
Create Profile from File. ..

== Quick Profile. .

@ Create Profile Wiew. ..

Create Mulkiple Profile Yiews. ..
Create Superimposed Prafile..,
Edit Profile Geometry. ..
Design Criteria Editar, .

Add Profile Yiew Labels L4

After selecting Create Profile From Surface, the following dialog box is
displayed:
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. Create Profile from Surface
Alignment: Select surfaces:
= IROADTE ] Detention Areas
Station range (& Existing Ground
&8 Roadway Surface
Alignment: -
Start: End:
0+00.00" 18+41.76'
To sample: |
Sample offsets:
0+00.00° T 1e44L7E
Profile list:
Station
Marie Description Tvpe | Data Source OFfset Update ... | Laver Skyle
Start End
Existing Ground | 1 Existing Ground  0.0000° Dynamic  C-ROAD-PROF Existing ...
<] (2]
[ Drraw in profile view ] [ Cancel ] [ Help ]
A

After selecting the desired alignment and surface, click the Add>> button to
create your new Existing Ground Profile in the Profile List. If you look closely
at the dialog box, you will see options for controlling which portion of the
alignment is sampled, as well as the ability to sample offsets. This is not very
different from Land Desktop.

After adding your new profile to the list, you can present it in a profile view
by clicking Draw In Profile View at the bottom of the dialog box.

NOTE Throughout the process, having to select both the alignment and the
surface in the various dialog boxes reduces the possibility of error. It also means
you don’t have to worry about what is current and what is not as you do with
Land Desktop.

Remember that the profile view is just a container that displays the profiles.
Conceptually, you only need to select your alignment and the desired profiles
you want to display. After you click Draw In Profile View, Civil 3D opens an
easy-to-use wizard that guides you through the process of creating a profile
view.
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. Create Profile Yiew - General

General Select alignment:

¥ ROAD1 v
Station Range -

Prafile view name:
Prafile Yievs Height PY - { <[Mext Counter(CP1]=) (gf';
Profile Display Options Descripkion:
Pipe Metwork Display
Data Bands Priofile view style:

b Major Grids v

Profile view layer:

C-ROAD-PROF

[ show offset profiles by vertically skacking profile views

[ Mext = I [ Create Profile View ] [ Cancel ] [ Help ]

4

As you step through the choices in the wizard dialog boxes, you'll be able to
configure the following to determine the organization as well as the
presentation of your profile view:

Profile View Name—To assist in keeping things organized, you must give this
profile view a name. As with all Civil 3D objects, you can accept the default
name that is displayed automatically, if you wish (for example, PV 1).

Station Range—If your profile is very long and you only want to present a
small portion of it, you can specify a desired station range.

Profile View Height—If you want to provide some additional white space
(margin) at the top or bottom of your view, just increase the View Height.

Profile View Style—The profile view style controls how the profile view looks.
In other words, it defines components such as grid spacing, vertical
exaggeration, titles, view direction, and so on.

Band Set—Selecting a band set adds preconfigured labeling to the top or
bottom of your profile view.

When finished specifying options, click Create Profile View and you are asked
to select a point in Model space to display the new profile view. Just as in
Land Desktop, you are selecting where the lower left corner of the profile view
will be placed.
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Once these choices are defined, they can be easily changed using the Profile
View Properties dialog box. Just right-click on a profile view and click Properties
from the right-click menu.

After the insertion point is selected, the profile view is displayed. Using the
Move command on a profile in Land Desktop was problematic, but in Civil
3D it’s not a problem. To move the profile view, you can use the standard
AutoCAD MOVE command to relocate it, or use the grip at the lower left
corner of the profile view.

il

ISR

i e o8 i HA g2
B B & 2 i i

00 200 00 00 5400 &+00

It’s now time to create your proposed profile. From the Profiles menu, select
Create Profile By Layout. You are then asked to select which Profile View you
will be using to create your new profile. After clicking on the desired Profile

View, the following dialog box is displayed:

%. Create Profile - Draw New

Aligriment:

5 Power Line ]
Hame:

Proposed Profils (d
Description:
General | Design Criteria

Profile style:

B Diesign Style v
Frofile layer:

C-ROAD-PROF
Profile label set:

) {Complet Label Sef v

o | [ camce | [ b
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NOTE When you are trying to select a Profile View in a drawing, you must make
certain that you click on a grid line rather than on a profile line. The grid lines are
part of the profile view object. The profile lines are profile objects. Even though
the two object types can be displayed together, it is important to understand that
the profile view and the profile are two separate and distinct object types.

Using this dialog box, you can give your proposed profile a name as well as
select styles to control how it is displayed and labeled. Accepting the defaults
will produce a proposed profile that looks very similar to a Land Desktop
profile.

After clicking OK, the following toolbar is displayed. Notice that the Profile
Layout Tools toolbar is very similar to the Alignment Layout Tools toolbar.
This is another example of the standardized user interface in Civil 3D.

Profile Layout Tools - Proposed Profile Q E]
W W Sy Ay A MY A B DED e
Select a command From the lawout bools PYI based

In Land Desktop, you could create proposed profiles graphically, through an
editor, or a combination of both depending on the information you have to
work with. The next section explores performing the same tasks using Civil
3D.

Create a Proposed Profile from Scratch Using the
Editor

By clicking the Insert PVIs - Tabular button on the Profile Layout Tools
toolbar, a dialog box displays that lets you create the profile by typing in PVI
stations, elevations, and vertical curve information. If you look at the top of
this dialog box, you'll notice that you can now create asymmetrical vertical
curves.
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. Insert PVIs
Wertical curve type
O Mone O Circular O Asymmetric
Skakion | Elevation | Curve Len
0+00. 00’ 700,260 0.000"
3+25.50° 704.670' 150,000"
£+15.22' £95.440° 150,000
10+22,31' 705.120'
< >
l [0]4 ] [ Cancel ] [ Help ]

Create a Proposed Profile from Scratch
Graphically

You can also use the Profile Layout Tools to create the geometry graphically.
You do not draw it using AutoCAD, and then convert it into a profile later,
as you did in Land Desktop.

By clicking the = button, you can select either Draw Tangents or Tangents
with Curves. On the drop-down menu, you can also select Curve Settings to
set the defaults. Once the command is initiated, you can simply draw the
Proposed Profile. As the profile is drawn, all of the necessary annotation is
created automatically.

Profile Layout Tools - Layout {1}

PRI S AR §

% | ¥ Draw Tangents
-4 Draw Tangents With Curves

“le' Curve Setkings, ..
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Define Proposed Profile Geometry Using the
Editor

After creating some or all of the Proposed Profile graphically, you can click

the Profile Grid View button = to open the editor (Panorama window). In
the editor, you can create or refine the Proposed Profile geometry.

a o, | PYI Station | PYI Elewation | Grade In | Grade Out | A (Grade Change) | Profile Curve Type 8
1 O+59.67 658,751 4.653% :'EJ
z 44+64.95" 677,730 +.683% 0.546% o
3 10+92.08" 653,038 0. 546% 5.000% ;E__
4 15+44,30° TOS.649 5.000% -2 32T
5 21+84.23 690,759 -2.327%
-]
=
=
=]
=
o
(=9
-
D

The column headings are similar to those in Land Desktop. This is another

example of where your Land Desktop experience is very relevant. Notice of

the “Grade In” Column. In Civil 3D, unlike Land Desktop, you can grade in
both directions.

| ' ' ' |
LW PT STA: 448338
d L PT ELEY: | BA3.02
P STAc 143511 . L { P OSTA 443841
Pl ELEW 508 3R PW ELEW: £92 38

W FTAT L -
L 150,00

' | '
HGH PT STA 1+BEET
HIGH PT ELEY: EB7.82

LYTH 5000 |

B S+EL4

=gy

Summary

It’s easy to see that creating alignments and profiles in Civil 3D is more
powerful and requires fewer steps than in Land Desktop. Also, the use of
built-in style features in Civil 3D assists in maintaining standards throughout
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your organization. Now that you have an understanding of how Civil 3D
handles alignments and profiles, let’s review how Civil 3D solves many of the
issues you may have had when working with these features in Land Desktop.

Land Desktop Limitation

Civil 3D Solution

Have you ever needed to reverse the direc-
tion of an alignment?

You can now quickly and easily reverse the
direction of an alignment. Just clcik the
Alignments menu » Reverse Alignment
Direction.

Have you ever wished you could rename
an alignment?

Renaming an alignment in Civil 3D is
simple and reliable. Right-click the align-
ment in the Prospector tree and click
Properties. Change the alignment name in
the Name field and click OK.

Have you ever had to edit your alignment
geometry and as a result had to recreate
your profile?

Because alignments and profiles are dynam-
ic objects, when you edit an alignment,
the corresponding profiles are automatic-
ally updated as well.

Have you ever experienced undesirable
results caused by someone moving your
profile?

Profile View objects do not rely on connec-
tions to external files. Therefore, they can
be moved using standard AutoCAD com-
mands.

Have you ever wanted to create more than
one finished grade profile for your align-
ment?

In Civil 3D, numerous profiles can be asso-
ciated with each alignment.

Plan Production

This section explores the plan production features in Civil 3D, and compares
them to Land Desktop plan production features.
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Plan Production in Land Desktop

Plan production in Land Desktop involves using the Sheet Manager to create
plan, profile, plan/profile, and cross section sheets that can be plotted. The
process involves many steps. Along the way, if any changes to your model or
annotation occur, frequently the plan production (sheet generation) process
would need to be started over again from the beginning. In many
organizations, these tasks are not started until a project has reached a certain
state of completion. This is to avoid having to do the same tasks over and
over again as designs evolve.

Plan Production in Civil 3D

The Civil 3D plan production features provide faster, and much more
automated functionality than the plan production features in Land Desktop.
The first thing that is important to understand is that in Civil 3D, the plan
production features are comprised of two wizards that allow you to quickly
create sheets along a selected alignment.

The first wizard—the Create View Frames wizard— creates objects called “view
frames” which are similar to viewports. This wizard asks you to select an
alignment in your model, and to specify some other options. You can accept
the defaults, or make changes to them. When the wizard completes, the “view
frames” are placed automatically along that alignment.

The second plan production wizard—the Create Sheets wizard— automatically
creates sheets from the data that exists within the boundaries of the view
frames, and displays it according to choices you make on the wizard dialogs.
Both wizards reference templates, which you specify, and which of course also
play a part in defining how the data in the sheets is displayed.

Just like the Create View Frames wizard, the Create Sheets wizard takes just a
few seconds to use. It is very easy to play around with this feature, creating,
adjusting, deleting, and recreating view frames and sheets until plans look
just the way you want.
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Summary

Now that you've reviewed plan production features in Land Desktop and in
Civil 3D, refer to the following table for a summary of how Civil 3D provides

the more efficient solution.

Land Desktop Limitation

Civil 3D Solution

In Land Desktop, creating plan sets is a task
that typically must wait till a project has
reached a state of near completion.
Drafters must wait till designers and engin-
eers give them a green light to begin the
plan production phase.

With Civil 3D, plan production tasks can
occur simultaneously with many engineer-
ing and design tasks. Drafters can begin
creating plan sets while designers and en-
gineers are still working on model data.
This enables plan production tasks to begin
and complete much earlier in the project
cycle, reducing the overall project timeline.

Have you ever spent hours or days revising
plan sets just because minor changes to
your model had to be implemented?

With Civil 3D, because plan production
features are dynamically linked to your
model data, updating plan sets when
model data changes can take just a few
seconds.

In Land Desktop, ensuring that plan sets
adhere to company standards is a tedious,
and error-prone process. Often visual edit-
ing or checking is the only way to ensure
that annotations and other data are repres-
ented as desired.

Because Clvil 3D includes style-based ob-
jects and labeling, keeping plan sets in
adherence with company standards is
faster and easier.
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Setting Up Styles in Civil

3D

As you move from Land Desktop to Civil 3D, you will want to take some time to understand
styles. Using styles provides you with enormous gains in productivity, precision, consistency,

and quality.

Styles control the appearance and sometimes the behavior of Civil 3D objects. By using styles
in Civil 3D, you have great flexibility in the presentation of design elements, including labels

and tables.

This chapter provides an overview of styles, explains how styles fit into the hierarchy of Civil
3D settings, and describes how to get started creating customized styles in Civil 3D.

Overview of Styles in Civil 3D

In Civil 3D, styles control the display of all the visual elements of objects, labels,
and tables. Using the styles you create, all elements of the design object are
automatically set to a specific linetype, color, and layer reference.

To get the most from Civil 3D, organizations can create customized styles,
according to their standards, which, along with various other drawing settings,
can be saved in a drawing template file (.dwt) for easy reuse. Having a drawing
template with styles that meet your company standards is one of the most
important steps you can make to ensure that you have a successful transition
to Civil 3D. As mentioned earlier in this guide, you need to make sure to devote
appropriate resources to developing styles for your organization.

In Civil 3D, there are various levels at which you can apply styles. For example,
you can assign styles at the object level (alignments, profiles, surfaces, pipe
networks, and so on), as well as at the object sub-component level (for example,
pipes and structures within a pipe network), and even specific styles for the
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various components of pipes or structures. You can also create styles for object
labels and tables. Having the ability to automatically update objects and labels
by simply changing a style is a tremendous time-saver over what you must
do in Land Desktop to update the appearance of an object.

You can create Civil 3D styles based on a company standard to represent all
the phases of a development project. For example, you may have a set of styles
that are applied to existing elements, and another set of styles for proposed
elements.

Alignment style collection on the Settings tab
in Toolspace

oo @l |

Active Drawing Settings View w

= & Surface 1~
+ B Parcel
= b Grading
=3 alighment
= ¢ Alignment Styles
1 Basic
B Existing L
B Layout
*a" Proposed
@ Design Checks
@ Label Styles
7 Lahel Sets

Prospector

Settings

Major Station

Minor Station

Geometry Paint

Profile Geometry Point
Station Equation

@ Design Speed

+- @ Superelevation Critical Points
@ Station Offset

Survey

7 Tangent Intersection
= & Tahle Styles —

=

+- 1 Segment -

Toolbox

Mame Diescription Created by [
1y Basic alignment style  Autodesk
1 Existing Autodesk
1 Layout alignment style  Autodesk |
<
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Style Considerations

Creating hundreds of styles can seem like a daunting task, but it is important
to remember that you do not have to create all styles at once. Review the
default Civil 3D templates and choose one of these templates as a starting
place. By modifying the styles in an existing template, you can create a
template specific to the needs and standards of your company.

Template choices in Civil 3D

/Select template

1

Look in:

e}

History
My Documents

0

Favorites

1

FTP

G

Desktop
e
W

Buzzsaw

I5) Template

Marme
|Flan Production
DIPFTWTemplates
[)SheetSets
[ear]_AUtDCAD Civil 3D (Irmperial) ..
| _AUDCAD Civil 3D (Irmperial) ...
gar| _AUEDCAD Civil 30 (Imperial) ...
gar| _AUIDCAD Civil 30 (Metric) NC...
gar| _AUIDCAD Civil 30 (Metric) NC...
ar| _ALDCAD Civil 30 (Metric) NC...
cad30. chwt
gar| 2Cad -Narmed Plot Styles3D.dwt
gar| 2Cad -Mamed Plot Styles,dwt
| 3Cad. chwrt
| SCadisn30, chart

JELELELE)

DDA

o

File name:

Files of type: | Drawing Template [*.duwt]
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Views w» Toolz -
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Civil 3D provides several drawing templates (imperial and metric) based on
National CAD Standards. These templates contain many pre-defined styles
for typical use in the land development industry. Use one of these templates
as a starting point to become familiar with styles.

Template

Description

NCS Base

This template contains a basic style for every element.
It is designed for the CAD manager who wants to
build a style catalog from scratch. This template
should be used only by experienced Civil 3D users
because there is little material in the template file to

modify.
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Template Description

NCS LDT This template contains styles that reflect the built-in
appearance of the AutoCAD Land Desktop profiles,
sections, points, and label styles. This template
provides a familiar feel to the software, making it
easier for you to move to Civil 3D and get acceptable
results quickly and easily.

NCS Extended This template contains multiple styles for almost every
Civil 3D object. The variety of use cases in this tem-
plate makes it a good place to start. The less experi-
enced CAD manager can use it to explore how styles
and labels are built. It also provides more experienced
CAD managers a wide variety of use cases.

Read the following section before you decide which approach to style creation
best fits your organization:

Who should create styles?

Before you start to develop a catalog of styles for your company, you have to
decide what approach to take. The amount of time and money that you can
afford to invest in style development are important factors when considering
the following options:

B Hire a consultant—If you have well-defined CAD standards in place, you
can hire a consultant to create your style catalog. With minimal guidance
and using existing work, he or she can create a template with styles that
will closely match your existing work. This approach will ease the burden
on a CAD manager.

B Do-it-yourself—If time allows, and your company wants to have an on-site
styles specialist, designate someone in your firm to build styles. This
provides an opportunity to develop a strong internal technical resource
who will develop competency in using Civil 3D while building styles.

B Combined approach—This approach is ideal if you can hire a well-trained
consultant to get you started with style development by meeting with your
team. He or she can help you set up your basic styles and instruct you
about style creation. You can make progress on a project using basic styles
and then create or modify styles as needed while work on a project
continues. After the initial style development, a designated resource person
can continue adding to your style catalog.
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ByLayer or Style

Another consideration is to determine whether you want the display of objects
and labels to be ByLayer or as defined in the style. On the Display tab of the
object style dialog box, you can either set up the style to obtain values ByLayer
or specify hard-coded values for each object component type. There are pros
and cons to consider for each approach.

PROS CONS
Values B Hard-coded display enforces M Difficult to manage downstream
defined in standards. data.
Style B Fewer layers to manage be- M Not intuitive to layer oriented
cause many elements are on users.
one layer. B Requires a style for every object
B Display of most styles is component.
done thr?ugh one dialog B Limitations in sharing data with
box and is faster than using those not using Civil 3D.
the Layer Manager.
Values con- B Familiar to AutoCAD users B Requires layering and AutoCAD
trolled ByLay- and display is easily manipu- Civil 3D standards to ensure con-
er lated through layer control. trols.
B Easier to share Civil 3D con- H Object component display is diffi-

tent between AutoCAD
products.

cult to track and change.

Styles Workflow

This section describes a basic workflow for creating and using styles.

To enforce CAD standards, styles should be managed through a drawing
template.

1 Create a drawing template (.dwi) that contains text styles, linetypes,
layers, and blocks that are standard for your organization. One way to
get started is to modify the styles in one of the .dwt files in Civil 3D. To
access the drawing templates, in Toolspace on the Prospector tab, select
Master View. Scroll to the Drawing Templates folder.

Styles Workflow | 73



2 In the drawing template, create styles for objects, labels, and tables. You
can start by copying the existing styles in the template and making
modifications to resemble your company standards.

3 Adjust the drawing and feature settings in the template so that new
drawings based on the template will contain your customized styles.

4 Save the drawing template on a server or some other location that is
accessible to all users.

5 When you create new objects, apply the desired styles.

6 Override style settings as necessary for specific objects or labels, to obtain
results for unique needs in a project.

7 Use the drag and drop capabilities to drag styles from one drawing into
another. You can drag styles between drawing collections on the Settings
tab, or into a drawing that is open in the drawing editor.

Styles Hierarchy and Creation

The Settings tab in Toolspace contains all the object style collections. The
templates in Civil 3D have pre-defined styles called Standard or Basic for each
object. Standard or Basic styles can be copied and modified to meet specific
display requirements. After you create an object style, you can assign the style
when you create an object. If necessary, you can change the specified object
style by modifying the object properties.

To create a new style
1 On the Settings tab in Toolspace, expand an object collection.
2 Select the object styles collection. Right-click » New.

3 In the Style dialog box, click the tabs and specify settings.

All styles have tabs for Information, Display, and Summary, and
depending on the object, there may also be tabs specific to that object.

Note that on the Display tab, by setting the View Direction to Plan, Model,
Profile, or Section, you can specify different display options for an object
or for an object type, depending on the type of view. For example, in
plan (2D) views, you may want pipe objects to display as red, but in
profile views, you may want them to display as black. Using the View
Direction options on the Style dialog box Display tab, you can easily and
quickly make these style decisions.
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The default object styles can be controlled at the object level or the command
level.

To set style defaults at the object level

1 On the Settings tab in Toolspace, select an object collection. Right-click
» Edit Feature Settings.

2 Inthe Edit Feature Settings dialog box, expand the Default Styles Property.
The default styles for the feature object are listed.

3 Click a cell in the Value column and click EI .

4 In the feature Style dialog box, choose from the following options:
B Select a style from the drop-down list.

m Click ﬂlll to pick a style from the drawing or click the drop-down
arrow for commands to create, copy, or edit.

B Click gl to view the Style Detail dialog box. The Information tab
lists the name and creation information. The Preview tab displays a
preview of the style. To preview other feature styles, select the style
from the Style drop-down list.

To set style defaults at the command level
1 On the Settings tab in Toolspace, expand an object collection.

2 Expand the Commands collection, right-click a command » Edit
Command Settings.

3 In the Edit Command Settings dialog box, expand the Default Styles
Property. The default styles for the command are listed. You have the
same options to create, copy, edit, or pick from drawing.

NOTE Assigning a new style default at the command level will override the
style that is assigned at the object level. The Override check box is selected
when you assign a style at the command level.
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Label Styles

Using label styles, you can easily annotate design elements. Like objects, if
you assign a new label style, labels are automatically updated to reflect the
applied style.

The basic process for creating and working with label styles is similar to object
styles, but because labels have more attributes, the specifics for label styles are
more detailed. However, the user interface for creating label styles is consistent
for all objects. Label styles are composed of general label properties, layout
parameters, and the dragged state display characteristics.

Like object styles, label styles are grouped in collections for each feature on
the Settings tab in Toolspace. Each object type has varying types of label styles.
For example, surface label styles include styles for contours and slope, while
alignment label styles include styles for stations and station offsets.

Label styles also have parent-child relationships. You can create a child style
that has the same properties of the parent style, but you can make changes
to these properties at the child level. Any property you don't specifically
change will be controlled by the parent style.

The General collection in Toolspace contains the Multipurpose collection of
styles. These styles are not associated with a specific object. In the General
Label Styles collection there are label styles for lines and curves that you can
use on Civil 3D objects such as parcels and alignments. In the General Label
Styles there is also a label style for Notes which can be used in situations where
you need to add a general purpose note that is not attached to a specific object.
You create the Note label styles in the same way as other label styles. They
also maintain dynamic text sizing based on the viewport scale.

In the Label style collections for Alignments, Profiles, and Sections, you can
create label sets. After you define the label style elements, you can group the
types together and create a label set to assign to an object.

The Label Style Composer

Use the Label Style Composer to create or edit the format and content for
label styles. The Label Style Composer has five tabs with the Information and
Summary tabs being similar to object styles. You use the General, Layout, and
Dragged States tabs to enter the specifics for the elements in a label.
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The Information Tab

This tab is where you specify a style name that reflects what the label style
will be, for example Parallel With Tick.

©. Label Style Composer - Parallel with Tick E
Information ‘Genera\ Layout | Dragged State | Summary
MName; Created by: Date created:
Parallel with Tick. Autodesk, 21242006 1:26:49 AM
Description: Last modified by: Date modified:
Style with station parallel with Tick. Autodesk, 3130/2006 4:30:03 PM
OF ] I Cancel ] [ Apply ] [ Help ]
|

The Label Style Composer | 77



The General Tab

This tab is where you specify the following visibility and orientation properties:
Label—Controls the text style, visibility, and layer for the label.
Behavior—Defines the location and orientation of the label.

Plan Readability—Determines the text readability in relation to the page.

Preview Window—Displays a preview of the selected style.

©. Label Style Composer - Parallel with Tick
Information | General |Layout | Dragged State | Surmary
Property Yalue Presisw :Etatlon Equation Label Styls| v |
=l Label
Text Style Standard
Wisibility frue
Lavyer CROAD-STAMN-IM...
= Behavior
Orientation Reference Chject
Forced Insertion MNone
Force Inside Curve false
= Plan Readability
Flan Readable frue
Readahility Bias 10,0000 ()

Flip Anchors with Text false

[al'3 ] [ Cancel ] [ Apply ] [ Help
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The Layout Tab

This tab is where you define the object components and their associated text
labels. You select a component name in the component list, such as Major
Station or Tick, and then specify properties. The list of properties varies,
depending on the selected component. For more information about the
properties of the Layout tab, see Managing Layout Properties for Labels in the
Civil 3D Help.

Information | General | Layout |Dragged State | Summary

Component name:

Station R @ E]
Property Value
= General
Mame Station
Wisibility frue
Anchor Component <Feature>
Anchar Point Anchor Station
= Text
Contents <[Station Yalueum...
Text Height 2.54rmm
Raotation Angle 0.0000 (d)
Attachment Bottom center
¥ Offset 0.00mm
' Offset 2.50mm
Allow Curved Text false:
W Color W BYLAYER
Lineweight ByLayer
= Border
Wisibility false:
Type Rectangular
Background Mask false
Gap 0.64mm
W Color W EBVLAYER
Linetype ByBlock
Lineweight ByLayer
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The Dragged State Tab

This tab controls the behavior of labels if they are dragged from the default
location. It has the following properties:

Leader—Controls the display of the leader.

Dragged State Components—Defines the text display, border elements, text
height, and leader attachment.

Information |General |Lavout | Dragged State | Summary

Property Walue

= Leader
Arrow Head Style Closed filled
Arrow Head Size 2.50mm
Visibility frue
Type Straight Leader

W Color W EBvLAYER

Linetype ByBlock
Lineweight ByLayer

= Dragged State Compon...
Digplay Stacked Text
Border Visibility false
Border Type Rectangular
Background Mask false
Border and Leader Gap  0.73mm
Text Height 2.50mm
Leader Attachment Middle
Leader Justification frue

W Color W EBYLAYER

Linetype ByBlock
Lineweight ByLayer

Table Styles

You use tables to represent Civil 3D data for points, parcels, alignments,
surfaces, and pipe networks. The process of creating table styles is similar to
that of objects and labels. For more information on table styles, see Table
Styles in the Civil 3D Help.
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Tips for Working with Styles

Use the following tips when you start working with styles:

There are potentially over 300 styles in Civil 3D. Don't try to create every
style at once. Start by modifying a Civil 3D template to create the basic
styles for your pilot project and add new styles as necessary.

While it is important for everyone using Civil 3D to be familiar with styles
and their application, in order to maintain consistency in company
standards, a best practice is to have one person control the creation and
maintenance of the styles template.

After you create a template that contains your styles, you can use the drag
and drop functionality to copy styles from the Settings tab into drawings.

You may want to create several .dwt files for the various aspects of a project,
for example Grading Plans or Finish Plans.

The defaults for the display of geometry label text in a drawing are set on
the Abbreviations tab in the Drawing Settings dialog box.

Use the View Direction field on the object style Display tab to set up
component appearance for the following types of views: plan (2D), model
(3D), profile, and section.
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Tools for Moving Data

This chapter describes the variety of tools and methods that are available for moving Land
Desktop data into Civil 3D.

There are many reasons why you may need to move or share data between Civil 3D and Land
Desktop. Perhaps you want to move data from a Land Desktop drawing into Civil 3D drawing,
or use Land Desktop for some tasks and Civil 3D for others, and move the data back and forth.
While the recommended approach is to start with a new project in Civil 3D, you may have
situations that require moving Land Desktop data into Civil 3D.

Overview of Moving Land Desktop Data into
Civil 3D

The following is a summary of the various ways that you can move Land Desktop
data into Civil 3D. Each of these is discussed in more detail in the following
sections.

B Open a Land Desktop Drawing in Civil 3D—You can open a Land Desktop
drawing in Civil 3D to view Land Desktop objects in Civil 3D as proxies or
as objects.

B Import Data From Land Desktop command—Use this Civil 3D command
to import surfaces, description keys, alignments, profiles, parcels, and pipe
runs from Land Desktop drawings and projects into Civil 3D.

B Convert Land Desktop Points command—Use this Civil 3D command to
convert Land Desktop points to Civil 3D points.

B Import a Land Desktop Point Data File—You can import an ASCII text file
or .mdb file of a Land Desktop points database into a Civil 3D drawing.
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B LandXML—Use the Civil 3D Import LandXML command to import
LandXML data that you previously exported from Land Desktop.

It is important to note that the process of sharing data between Land Desktop
and Civil 3D is not dynamic. In other words, changes that you make to the
data in one program will not be automatically transferred to the other program.

Before you begin moving data between Civil 3D and Land Desktop, you should
always verify that you are using the same coordinate and unit system to avoid
conflict and confusion.

Opening a Land Desktop Drawing

When you open a Land Desktop drawing in Civil 3D, Civil 3D does not convert
the data. However, you can view Land Desktop objects in Civil 3D as proxies
or as objects.

When you open a Land Desktop drawing in Civil 3D, the following occurs:

B Geometric data, such as contours, quick sections, grading objects, and
curve text, are displayed in Civil 3D as Land Desktop objects. For more
information, see the Civil Object Enabler Help.

B Geometric data, such as alignments, profiles, sections, pipe runs, hydrology
graphs, sheet layouts, and plotted sheets in paper space, remain in the
drawing as AutoCAD primitives (lines, arcs, and text).

B Land Desktop labels remain in the drawing as AutoCAD MText
components.

Each drawing is associated with various settings that are specific to Land
Desktop, which are stored in an external file named <drawing name>.dfm. This
data is not brought forward into Civil 3D.

Setup Object Conversion

Civil 3D reads the setup object as soon as the Land Desktop drawing is opened
in Civil 3D and translates certain aspects into the Civil 3D drawing settings
for the session.

NOTE If you close the drawing without saving it, then the original setup object
remains intact and you can open the drawing again in Land Desktop.
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Some information in the Land Desktop setup object is translated into Civil
3D and some is not, as described in the following table:

Land Desktop Setup Object

Civil 3D Drawing Settings

Linear units Translated to drawing units
Angle units Translated to angle units
Angle display style Not translated

Linear, Coordinate, Elevation, and Angular
precision

Translated to similar entries in the Ambient
Settings

Horizontal scale

Translated to scale

Sheet size

Not translated

Coordinate system (zone)

Translated to Zone settings in Units and
Zone Settings

Base Point and North Rotation

Not translated

Miscellaneous information (for example,
border)

Not translated

Using the Import Data From Land Desktop
Command

If you need to import surfaces, description keys, alignments, profiles, parcels,
or pipe runs from a Land Desktop project or drawing into Civil 3D, you can
use the Civil 3D Import Data From Land Desktop command.

This command imports the Land Desktop data into the current Civil 3D
drawing. Because Civil 3D stores all objects in drawings, the drawing does not
have to be associated with a project. However, if you are using the Civil 3D
project management features (Autodesk Vault), you can associate the current
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drawing with a Civil 3D project and check the data (points, surfaces, and
alignments) in to a specified project.

It is important to note that data units cannot be converted when using the
Import Data From Land Desktop command. Therefore, you must import an
imperial-based project into an imperial-based drawing, for example. If you
want to convert units during the import, you must use the LandXML import
feature.

It is also recommended that you import one data type at a time. For example,
first import surface data and then repeat the procedure to import description
keys or other data types, one data type at a time.

To import data from a Land Desktop project

1

Click File menu » Import » Import Data From Land Desktop, or enter
ImportLDTData at the command line.

In the Import Data From Land Desktop Project dialog box, enter a valid
path, or click ﬂ to browse to the project root folder and select a path.
For example, C:\Land Projects <version number>.

In the Project Name list, select a project from which you want to import
data.

After a valid project name is selected, the available data that you can
import is displayed in the dialog box.

Specify an Alignment Site. If you leave the default site at None, the
Alignment data is placed in the Alignments collection, rather than in a
Site collection.

Navigate to the data you want to import.

Select or clear the check boxes for one or more of the following features:

TIP To obtain the best results, import only one data type at a time.

B Description Keys: Imports description keys. When you update a
drawing template, it is a best practice to select this option.

B Surfaces: Imports surface data.

B Alignments: Imports alignment data.
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10

NOTE To migrate a Softdesk alignment database, you must convert it
into a Land Desktop 3.x through Land Desktop 2009 database before
importing it into Civil 3D.

B Profiles: Imports both EG (existing ground) and FG (finished ground)
profiles.

NOTE When importing a profile without an associated surface or
alignment, the profile will be static in Civil 3D.

B Parcels: Imports parcel data that was created using the Land Desktop
parcel manager to the specified site.

B Pipe Runs: Imports pipe run data.

NOTE Before importing Land Desktop pipe run data, make sure that the
Civil 3D pipe network Parts Catalog (Parts List) has the part sizes that
make sense for the pipe network you will be importing. For more
information, see Part Catalog and Parts Lists in the Civil 3D Help.

Optionally, create new sites to separate the data. Right-click Sites »
New. The new site will appear under the Sites collection. You can move
parcels and alignments (and associated profiles) by dragging them into
different sites.

Either click Apply, to iteratively import and check messaging, or click
OK.
A message box is displayed, indicating the status of the import. Click OK.

Either go to Step 10 or, if you have completed an iterative import process
using Apply, click OK.

NOTE Imported objects take on the default style for each object.

Verify the data using the following methods:

B Description keys: In Toolspace, on the Settings tab, expand the
Description Key Sets collection under the Point collection and verify
that the description key files are listed.

B Surfaces: In Toolspace, on the Prospector tab, click the Surfaces
collection (for the current drawing) and verify that the new surface
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is included. (You may need to right-click the feature and click Zoom
To to see the surface in the drawing.)

B Alignments : In Toolspace, on the Prospector tab, if you specified a
Site in the Import Data From Land Desktop Project dialog box, verify
that the site is included. If you did not specify a Site, expand the
Alignments collection and verify that the alignments are included.

B Profiles: In Toolspace, on the Prospector tab, if you specified a Site in
the Import Data From Land Desktop Project dialog box, verify that
the site is included. If you did not specify a Site, expand the
Alignments collection and verify that the profiles are included.

B Parcels: In Toolspace, on the Prospector tab, , verify that the site you
specified for the parcels is included. If you did not specify a Site,
expand the Parcels collection and verify that the parcels are included.

B Pipe Runs: In Toolspace, on the Prospector tab, click the Pipe Networks
collection and ensure that the pipes are included.

Converting Point Data from Land Desktop

In Civil 3D, you can use the Convert Land Desktop Points command to convert
Land Desktop points in a Civil 3D drawing to Civil 3D points.

You may choose to use this command if you do not have Land Desktop
installed, or anytime you have non-Civil 3D point objects (for example, Land
Desktop point objects) in your drawing that need to be converted to Civil 3D
point objects.

Using this command, you can set a variety of point settings. For example, you
can set default layers, point creation settings, and more for the points you
will be converting. You can automatically add the converted points to a
newly-created point group or to an existing point group. The existing Civil
3D point number and point name conflict resolution rules are used if a point
ID conflict occurs during the conversion.

For more information, see Converting Land Desktop Points in the Civil 3D
Help.

To convert Land Desktop points

1 In Civil 3D, click Points menu » Utilities » Convert Land Desktop
Points, or enter ConvertLDTPoints at the command line.
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2 In the Convert Land Desktop Points dialog box configure point setting
parameters by expanding the parameter, selecting a setting, and then
specifying a new value in the Value column.

3 To assign the Land Desktop points to a point group, select the Add Points
To Point Group check box, and then either select a point group from the
list or create a new point group. If you create a new point group, it is
added to the Add Points To Point Group list.

4 To keep the existing layers referenced by the Land Desktop points, select
the Preserve Original Point Layer check box.

NOTE When this check box is selected, the existing layer of the Land Desktop
point is assigned to the Civil 3D point when it is converted. In the Point
Creation settings, if the Disable Description Keys setting is set to False, and
the Land Desktop point matches a description key, the original point layer
will still be preserved.

5 Click OK.

Importing Point Data from Land Desktop

If you need to import point data from a Land Desktop project, you can import
the external Land Desktop point data (database) file into Civil 3D.

Civil 3D can import point data from an ASCII (text) file or a Microsoft® Access
.mdb file into a drawing. Before you import points into Civil 3D, you must
create a point file format that describes the layout of the point data in the
point data file. For more information, see Understanding Point File Formats
and Creating Point File Formats in the Civil 3D Help. You can add the imported
points to a point group, make adjustments to the data as it is imported,
including elevation adjustments, coordinate transformation, or coordinate
data expansion, and specify how the imported points are numbered as they
are created.

For more information, see Importing Point Datain the Civil 3D Help.

To import point data

1 In Civil 3D, specify the Point Identity settings, which control the point
numbers of the created points. For more information, see Editing the
Point Identity Settings in the Civil 3D Help.

2 Click Points menu » Import/Export Points » Import.
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3 Inthe Import Points dialog box, specify the point file format that describes
the layout of the data in the point data file you are importing.

4 In the Import Points dialog box, select External Project Point Database
as the format type and select the Land Desktop point database .mdb file
as the source file.

5 Optionally, specify a point group to which the imported points are added.

6 Optionally, specify advanced options for elevation adjustment, coordinate
transformation, or coordinate data expansion.

7 Click OK to import the points.

Using LandXML Export and Import

Using the LandXML export and import features, you can export data from
Land Desktop and import it into Civil 3D.

The LandXML import and export features are based on the LandXML schema.
For detailed information about exporting and importing using LandXML, go
to www.landxml.org, or you can refer to the Civil 3D or Land Desktop Help.
The following sections summarize how this functionality works.

LandXML Export

Whether you are exporting from Land Desktop or from Civil 3D, the process
is similar. To export a LandXML file from Land Desktop, click Projects menu
» Export LandXML. The LandXML Export dialog box is displayed. You can
choose to export the point, surface, parcel, alignment, and pipe run data from
the drawing.

In Civil 3D, to export data to a LandXML file, either click File menu » Export
» Export To LandXML, or right-click an object collection in the Prospector
tree and select Export.

In Civil 3D, when you export from the Prospector tree, the Export To LandXML
dialog box contains a pre-defined selection set of the data in that collection.
When you export from the File menu, all drawing data is selected by default,
and you can adjust the selection by clearing check boxes. Alternately, you can
specify the objects to export by selecting them from the drawing.

The following sections provide step-by-step information on the process.
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To export LandXML data from Land Desktop

1

In Land Desktop, either click Projects menu » Export LandXML, or
enter LandXMLOut at the command line.

The LandXML Export dialog box is displayed.

To refine the data selection, use any or all of the Points, Surfaces, Parcels,
and Alignments buttons. Each of these buttons displays a dialog box in
which you can specify data in the project to export.

To export the selected data, you must select the check boxes next to the
buttons. For example, to export pipe runs, select the All Pipe Runs check
box. If you clear a check box, then the data is not exported.

If you choose to export surfaces, parcels, or alignments, you can export
COGO point references instead of coordinates for the parcel and
alignment geometry.

Under Export Options, click Data to specify the precision settings for the
exported data, the imperial unit foot type, the units of exported angles
and directions, and whether to export raw descriptions, full descriptions,
or both.

Under Export Options, click File and specify the reference location for
the schema, the default destination location for the exported LandXML
file, and whether to export detailed or minimal XML. You can also specify
that the exported file is read-only.

It is recommended to set the coordinate precision to six places when
exporting data for data exchange, transfer, or archiving. You can change
the coordinate precision in the LandXML Export Data Options dialog
box.

To export LandXML data from Civil 3D

1

In Civil 3D, either click File menu » Export » Export To LandXML,
or enter LandXMLOut at the command line.

The Export To LandXML dialog box contains a data tree, where you can
select any of the major data collections for export to the LandXML file.

2 Do one of the following:

B Select or clear the check boxes to filter the data types that you want
to export to the LandXML file. Then click OK.
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NOTE The check boxes have a tri-state display. If only some objects are
selected under a collection, the check box is dimmed ; if all the items
are selected, the check box is selected ; if all the items below the

collection are cleared, the check box for the collection is cleared L.

B If you want to select data in the drawing, click ﬁl and select the
objects in the drawing. Press Enter when you finish selecting the
objects.

3 In the Export To LandXML dialog box, enter the name of the LandXML
(*.xml) file you want to export. Click Save.

LandXML Import

After you have Land Desktop data exported to a LandXML file, you can easily
import it into Civil 3D using the LandXML Import command.

To import data from a LandXML file into Civil 3D, first specify the import
settings that control the data for import. Then, select the files and the specific
data in the file that you want to import.

The LandXML import functionality automatically handles the conversion
between the units specified in the LandXML file and the current drawing units
specified in Civil 3D.

It is important to note that LandXML does not transform coordinate systems
automatically. Therefore, no specific coordinate system transformation is
applied other than what is specified by the translation and rotation settings.
For more information, see Translating and Rotating LandXML Data in the
Civil 3D Help.

The following section provides step-by-step information on the process.

To import LandXML data

IMPORTANT Before importing an .xml file, you must open a drawing, such as a
drawing based on a Civil 3D template, that contains Civil 3D styles. .

1 In Civil 3D, either click File menu » Import » Import LandXML, or
enter LandXMLIn at the command line.
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2 In the Import LandXML dialog box, select or browse to the LandXML
(*.xml) file you want to import. Click Open.

3 In the Import LandXML dialog box, select a site for the parcels. For the
alignments you can specify a site or specify None.

4 The data tree displays each of the major data collections in the LandXML
file. Use the data tree to:
B Navigate to a data collection and view its subcomponents.
B Expand the collections. Select or clear the check boxes to filter the

data types that you want to import into the drawing. By default, all
data components are selected for import.

NOTE The check boxes have a tri-state display. If only some objects are
selected under a collection, the check box is dimmed ; if all the items are
selected, the check box is selected ; if all the items below the collection
are cleared, the check box for the collection is cleared 0.

5 Click OK to import the LandXML file.

After you click OK, the data is imported into the drawing. The data
components are added to the applicable data collections in the Prospector
tree.

As each object is imported, you can use the Event Viewer Vista dialog box to
view the status of each operation. For more information, see The Event Viewer
Vista in the Civil 3D Help.

Civil 3D Migration Commands Summary

This section provides a quick summary of the Civil 3D migration commands
that have just been discussed. Note that in Civil 3D, you can access the
migration functionality either on the menus, or by using the following
commands at the command line.

Command Description

ImportLDTdata Imports description keys, surfaces, align-
ments, profiles, and parcels from a Land
Desktop project into Civil 3D.
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Command Description
LandXMLIn Imports LandXML data into Civil 3D.
ConvertLDTPoints Converts Land Desktop points in the

drawing to Civil 3D points.

ImportPoints

Imports external project point databases
into Civil 3D.
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Adopting Civil 3D
Project Management

Civil 3D includes a range of features for managing your engineering projects. Once you
understand these features, you can determine the best data structure and workflow to use in
your organization. This chapter takes an in-depth look at Civil 3D project management options
and discusses how to implement them in your organization.

Overview of Civil 3D Project Management
Features
Because designers, civil engineers, and drafters typically work in teams, Civil
3D provides several methods for sharing data. The ways that you choose to use
these features will be a factor in deciding how you want to manage shared data,

and in deciding what level of project management features you need to
implement in your workflow.

The three main methods that can be used for sharing data in Civil 3D are:
B External references (xrefs)
B Data shortcuts

B Object references in Autodesk Vault

Each option is discussed in the following sections.
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Using External References

An external reference (xref) inserts the entire contents of another drawing
into the current drawing as a display-only object. Since this is a standard
AutoCAD function, and since Land Desktop and Civil 3D are both built on
top of standard AutoCAD functionality, this function exists in both Land
Desktop and in Civil 3D.

To insert external references in Civil 3D, or Land Desktop, click Insert menu

» External Reference and insert a specified .dwg into your current drawing.
Objects in the referenced drawing cannot be edited, but you can use the Layer
Manager to control the display of separate components.

When deciding if you should use external references, consider the advantages

and limitations noted in the following table:

Advantages

Limitations

External references are versatile and easy
to use for different .dwg types, whether
they contain a single object or a complete
design. You can also label xrefed objects,
as well as create section views from a cor-
ridor xref.

Because they are display-only, external
references provide limited access to object
data, such as surface elevations or align-
ment length. For example, you cannot
create a surface profile from a surface in
an external reference. Both data shortcuts
and Autodesk Vault object references
provide access to object data.

Updates to the external drawing appear
automatically in the host drawing when
the drawing is opened, and notification of
updates is provided during the host draw-
ing session.

External references provide no inherent
security. Anyone can break links by moving
or renaming referenced files.

All the content of the reference drawing is
displayed, such as a base drawing contain-
ing parcel layout, existing ground inform-
ation, or a proposed grading plan.

External references can be used with either
data shortcuts or Autodesk Vault.

Labels can be applied to xref objects.
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Some sample uses for this feature include:

B Display a parcel layout within an alignment drawing.

B Display existing ground information within a design drawing.
B Display adjoining project phases in a plan set drawing.
|

Reference a corridor drawing into a sections drawing.

The following best practices are recommended when using external references:

B Select Relative Path as the path type when creating external references.
Where all document users share the same network environment, use UNC
(universal naming convention) paths to provide a flexible but accurate
path to each referenced file.

B It is recommended that you use external references when you will not
need to manipulate objects within the referenced file. This might be the
case when you import drawings of adjoining surfaces into a drawing.

Using Data Shortcuts

Data shortcuts are a feature specific to Civil 3D. The feature does not exist in
Land Desktop or in basic AutoCAD. In Civil 3D, a data shortcut provides a
complete reference copy of an object that you can import into one or more
other drawings.

Data shortcuts can be created only for surfaces, alignments, profiles, pipe
networks, and view frame groups (a Civil 3D object used in plan production).
They provide reference links between drawings without the use of a database.
When you create data shortcuts from a drawing, they appear on the Data
Shortcuts node of the Prospector tree. From this location, you can insert a
reference object into another open drawing by right-clicking its shortcut.

Objects in the consumer drawing have access to the geometry of the reference
object in the data shortcut. This geometry can be modified only in the source
drawing. However, display styles and labels for the reference object can be
modified in the consumer drawing.

The working folder represents a single work environment, including the
complete set of related drawings and data shortcuts for one or more engineering
projects. The Data Shortcuts node on the Prospector tree displays only the
shortcuts from the current working folder. Each shortcut is defined in a small
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XML file, stored in the _Shortcuts folder of the working folder. Most users do

not need to work with these XML files.

When an object is updated in the source drawing, notification appears in the

main application window and in the Civil 3D Toolspace Prospector.

When deciding whether to use data shortcuts, consider the advantages and
limitations noted in the following table:

Advantages

Limitations

Data shortcuts provide a simple, direct
mechanism for sharing object data that is
based solely on drawings, without the ad-
ded server space and administration needs
of Autodesk Vault. This can be ideal for
small teams or small projects.

Data shortcuts cannot provide data version-
ing.

Data shortcuts offer access to object geo-
metry in a consumer drawing while ensur-
ing that the object geometry can only be
changed in the source drawing.

Data shortcuts provide no security or data
integrity controls.

Reference objects in the consumer drawing
can have styles and labels that are different
from the source drawing.

Unlike Autodesk Vault, data shortcuts do
not provide a secure mechanism for shar-
ing point data or survey data.

Reference objects automatically update
when you open a file in which you have
referenced data.

Maintaining the links between the source
drawings and the consumer (referenced)
drawings requires a static location on the
shared file system.

During a drawing session, you are notified
when a source drawing has been modified,
both in the Communication Center, and
on the Prospector tab in Civil 3D
Toolspace.

If you want to check a drawing (.dwg) that
has data shortcuts into Vault, the shortcuts
must be deleted, then rebuilt as Vault ob-
ject references.

Note that if you want to implement Vault later, you can import your data
shortcut projects. The shortcuts are automatically converted to Vault references.
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Some sample uses for this feature include:

B Reference a surface and a pipe network into a drawing where you want to
design a grading plan. You can grade to the target surface even though it
is just a reference.

B Reference a surface and a related alignment into a drawing where you want
to create profiles in a profile view. This data structure enables you to keep
profiles in a separate drawing from the alignment in accordance with the
best practice of “one object per drawing.”

As a best practice when using data shortcuts, in a network environment, it is
recommended that you use UNC paths to provide a flexible but accurate path
to each source drawing.

Using Autodesk Vault

Autodesk Vault is the recommended project management solution for large
design teams working with Civil 3D.

When using Autodesk Vault, a main database resides on a designated server,
such as a file server on the network, and client software is installed on each
computer that requires access to the database. If you have offices in different
locations, you can use the multi-site option in Autodesk Vault. This means
that multiple offices with local file stores can share a single SQL instance and
manage files like a single database.

Using Autodesk Vault, you can share surfaces, alignments, profiles, pipe
networks, points, survey data, and view frame groups.

When deciding whether you should use Autodesk Vault project management
features, consider the advantages and limitations noted in the following table:

Advantages Limitations

Autodesk Vault is a robust database man- ~ Autodesk Vault requires at least double the

agement system that provides user secur-  disk space needed by other project man-

ity, data integrity protection, version con-  agement systems, because all files exist

trol, and backup and restore functionality. ~ both in the Vault file store, and in one or
more external working folders.

Using Autodesk Vault | 99



Advantages Limitations

Autodesk Vault facilitates design collabora- ~ Autodesk Vault requires ongoing server
tion among large teams, and is easily scal-  administration activities.
able as a team grows.

Autodesk Vault incorporates new features ~ The learning curve for adopting the Vault
from Autodesk and Microsoft as they be-  workflow is slightly more complex than for
come available with software upgrades. the other two data sharing methods.

Shared objects can be easily created when
a drawing is checked in to the database
and these are managed effectively by Vault.

You can use “project templates” that come
with Civil 3D when creating projects in
Vault.

Autodesk Vault provides a workflow and
technology that ensures that design data
and drafting remain in synch across all
project drawings.

In addition to managing surfaces, align-
ments, and other objects, Autodesk Vault
references also provide secure manage-
ment of survey data and point data.

An optional multi-site feature supports the
sharing of individual vaults by geographic-
ally separated workgroups. This feature
supports the same data management and
backup functionality as Vault on a local
network.

Some sample uses for this feature include:

B Reference a surface and an alignment into a drawing where you want to
design a parcel network. The parcel design can read the surface and
alignment geometry. You can also apply display styles and labels that are
relevant to the parcel design process to the surface and the alignment.
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B To create a plan set drawing, reference in several profiles and a surface
created from a corridor.

The following best practices are recommended when using Autodesk Vault:

B Designate one team member to be trained as a system administrator who
will regularly perform Vault administrative duties.

B Assign database access permissions to user groups rather than individuals.
This means you can change the permissions for an entire group, and change
the permissions for an individual(s) by moving them to another group.

Understanding Autodesk Vault

Integrated into Civil 3D software, Autodesk Vault is a data management system
for sharing design data across project teams, and across multiple locations.
Autodesk Vault allows you to manage not only DWG files, but all of your
engineering and related data, such as hydraulic designs, analyses, and data
generated from Microsoft® Office applications or other design software.

As a comprehensive file management and version control solution, Autodesk
Vault provides an effective way for engineering teams to simultaneously share
design objects within the same project. It includes a server component that
acts as the database and provides administrative tools, a client component
that is integrated with Civil 3D, and a stand-alone file system management
tool.

With Autodesk Vault, your data stays secure and is less likely to be
unintentionally corrupted, because you determine who can manipulate data,
and who can just view it. By providing multiple team members with parallel,
controlled access to designs, Autodesk Vault helps you maintain data integrity
across large and complex projects. With Autodesk Vault, your project teams
work more efficiently, complete projects faster, and reduce the risk of errors.

Implementing Autodesk Vault

By implementing Autodesk Vault, your project teams can access the data they
need to complete their work. This section outlines how to:

B Choose between single-site or multi-site Vault architecture

B Organize your projects
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B Set up working folders

Single-Site or Multi-Site Architecture

A single-site configuration is recommended for most teams. The Autodesk
Data Management Server (ADMS) component is installed on one system, and
the client component is installed on each computer that must communicate
with that server. The server stores all master copies of data files, and the clients
can access the files stored on the server. For best performance, a dedicated
server is recommended for the ADMS component.

Vault single-site architecture

SQL Server
(Shared Metadata)

Web Server and
File Store

‘

Client 1 Client 2

You have flexibility within this model to choose a configuration that suits
your requirements, based on criteria such as the number of users who must
share data, how your users are divided into design teams, and the amount of
project data you expect your users to generate. For more details, refer to the
Autodesk Data Management Server Installation Guide.

The optional multi-site feature in Vault is designed to support geographically
dispersed workgroups sharing vaults. A single instance of remote SQL manages
multiple servers, each with its own file store, at separate office sites. Depending
on their level of permissions, all users can see all files at all sites as if the system
is a single database.
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Vault multi-site architecture

Site A
Web Server &
File Store

Site B
Web Server &
SQL Server File Store
(Shared Metadata) \\_
L]
S
Client 1

Client 2

Client 3
When a user checks out a file that is stored at another site, the system replicates
that file at the user’s site. As long as the file remains shared, the system

Client 4
remembers to update that copy with any changes. Vaults and individual files
are replicated only where they are really in use. Backup and restore operations
can be managed from any site that has all vaults enabled. For more
information, see ADMS Console Help.

Organizing Your Projects

Autodesk Vault can be set up in a variety of ways, so you can manage and
store your projects in the manner that best meets your business needs. Below
you will find information about three ways—using a single vault, using
within Autodesk Vault.

multiple vaults, or using folder permissions—to organize your Civil 3D projects

Single Vault—The simplest way to organize your projects with Autodesk Vault
is to use a single database—also referred to as a “vault”—to store all projects

and their information. You create only one database on the server and store
all Civil 3D projects in that database. All team members have access to this

one location, and you set up access control and user names only once. By

using a single vault to house all projects in the same location, you centralize
project access for all team members, making it easier to find project data.

It is best to use a single vault for all projects when you have a single office or

your teams are centrally located and connected through a local area network
(LAN). With a single vault, you reduce both your IT and project management
overhead. If your organization has multiple offices connected through a wide
area network (WAN), you can still employ a single vault. In this case, all users

simply access the vault through a virtual private network (VPN). The drawback

Organizing Your Projects | 103



to this scenario is that if the WAN connection is compromised, remote offices
are cut off from the project server.

Alternately, organizations with multiple offices can choose to set up an
Autodesk Vault in each office, configuring each with a single vault database
for all projects. While this puts more maintenance burden on your IT staff, it
does allow your project teams to access project servers regardless of the WAN
status.

While user permissions are assigned at the vault level, they can be refined at
a lower level, such as a project, or a folder within a project. For example, the
Alignments folder in the Source Drawings folder of the <Project> can have
read-only access for the Drafting group, and edit permissions for the Design
group, and so on.

Multiple Vaults— In some cases, it may be advantageous to partition your
data into multiple vaults on the same server. For example, you may choose
to keep projects organized by year, in which case you would create a vault for
every year. Thus, you could have several office locations with their own
Autodesk Vault to log onto, using the following hierarchy: Location \ Year \
Project.

For example, a project named “J06068” could reside in the “2006” folder that
is in the “Jackson” folder. In other words, the folder structure would be:

\Jackson\2006\J06068.

Folder level Description

\ Jackson This denotes the location where the Vault server resides.

\ 2006 This denotes the year of the project.

\ J06068 This denotes the name of the project, and includes a meaningful

prefix. In this example, the project name uses a “|” prefix to indic-
ate the office that originated the project—in this example “Jack-

"

son.

ul "

Folder Permissions—This approach works well if you have several departments
within your organization that use Civil 3D. Each department—such as your
survey, site, or highway departments—gets its permissions according to project
folders. This allows you to manage departmental permissions and access to
projects separately. For example, you can assign write access to your surveyors
to only their folders within the project, while providing site and highway
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teams with read-only access that allows them to consume (use, copy, display)
but not edit survey data.

Organizations with very large, multi-phased projects may want to assign a
separate vault for each project for ease of project management. If you elect to
partition your data into multiple vaults on a server, your project teams will
experience shorter project lists and tighter control over data access. However,
there are some disadvantages. Projects reside in different locations and your
users have to remember multiple vault names and locations. Also, backing up
and maintaining multiple vaults is more work for your IT department.

Note that user permissions apply within a single vault, and cannot be shared
across vaults. The Autodesk Data Management Server Installation Guide provides
more detailed information on the difference between a single vault
configuration and a multiple vault configuration.

Setting Up Working Folders

When you work on particular design objects, such as road alignments or pipe
networks, you check the associated drawings out of a vault and work with
them in working folders (the location where checked-out or open work in
progress is stored). Working folders mirror the project folder structure in
Autodesk Vault.

When you check out or get files from a project, they are physically copied
from the file store to the working folders and then tagged as “checked out”
in Autodesk Vault. You can then edit the files from within the working folders,
with the assurance that while other users can still get read-only copies of the
files, they cannot check them out for editing until you have checked them
back in. This way, you maintain a single version of each drawing while still
allowing team members to share data within the drawing.

When you check a file back into a project, Autodesk Vault copies the revised
version from your working folder to the File Store on the server. Autodesk
Vault marks the file with the appropriate revision data and makes it available
to other users.

You can change the location of the working folder by accessing the Prospector
Toolspace from Civil 3D and selecting Set Working Folder. If your project
manager or administrator has already enforced a specified location for a
working folder, any custom location is overridden.
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You have three choices for setting up working folders:

B Individual users on a project can have their own working folders on their
desktop computers.

B Everyone in the organization can share a working folder on the server.

B Individual users can each have a dedicated working folder on the server.

Working Folders on Individual Local Computers

When working folders are kept on local computers, it minimizes network
traffic and accommodates team members who may work offline from the field
or a home office. By setting up working folders locally, users create network
traffic only when they check in or check out files from the vault. The
disadvantage of this choice is that the project files are stored on the local
machine, which can make them unavailable for the backup system. In addition,
using external references (xrefs) and Sheet Set Manager (SSM) to share files is
a more manual process. This set-up also requires more storage capacity on the
local machines, because the project files that users check out are copied locally.

Individual Working Folders on the Server

By maintaining private working folders on the server, you secure an individual’s
work-in-progress from other users who may be less familiar with the proper
means of interacting with Autodesk Vault data. Locating these folders on the
server also allows for nightly backup of the data. The drawback to having
individual network working folders on the server is the increase in network
traffic. Additionally, if you do a nightly backup of the folders, you may have
a lot more data than you really need, because you may back up multiple copies
of the same files in each folder.

Working Folders on the Server in a Common Folder

With this approach, all users in your organization access a common folder on
the file server when checking out and modifying files. It may also be more
familiar, as many organizations already use a centralized data or projects folder
for their drawings. Similar to individual working folders located on the server,
a shared working folder can be backed up nightly, ensuring project data
security. However, since it is a common location, the backups will be smaller
in size than with the backups of individual working folders. The benefit of
this approach is that drawings that have data references or external references
will be notified and updated every time they are saved, rather than only when
they are checked back into the vault, as with the other two approaches. The

106 | Chapter 5 Adopting Civil 3D Project Management



drawbacks to having a common working folder on the server are the increase
in network traffic and the inability of users to take full advantage of securing
data as they can when using local working folders.

Project User Interfaces

To work in and manage Civil 3D projects stored in Autodesk Vault, you can
access one of two user interfaces: either the Civil 3D Prospector Toolspace or
the Autodesk Vault administration tool. Often you can use either for a specific
task, but in certain situations there are distinct advantages to using one or the
other. You can also perform certain functions, such as checking in files, from
some Microsoft Office applications. These interfaces are explored in the
following sections.

Prospector Toolspace

It is recommended that you use the Prospector tab in the Toolspace window
within Civil 3D to create all projects. After creating a new project, it will show
up in the project tree in Civil 3D. You can also view, edit, and manage drawings
and Civil 3D object data stored in a vault with the Prospector tab in Toolspace,
as shown in the following illustration:
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If you are logged in to Vault, you can use the Prospector tree to create a new
project in the project database. You create the project using either the default
Sample Project template, or another template you have saved. Project templates
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provide the capability to create a new project with a predetermined folder
structure, where each folder can also contain files of any type. The template
folders are found in the Civil 3D Project Templates folder on your local disk.

To work on a drawing, use the Check Out command on the Prospector tab in
Toolspace to copy the file to your working folder and then open it for editing
in Civil 3D. After you finish working on the drawing, use the Check In
command to save changes to the master folders in the file store. If you need
to view a file without editing it, you can use the Open Read Only command.
To save a new file to a project, you choose Add To Project on the Prospector
tab in Toolspace.

NOTE Civil 3D includes project templates, which provide a standard folder structure
for projects.

Vault Administration Tool

The Vault Administration tool is a stand-alone application that you can use
to manage project files in a vault—from outside of Civil 3D. It is installed
automatically when you install Autodesk Vault. The Vault Administration
tool window, shown in the following illustration, lists projects as folders, and
includes a list of all versions of a selected file. Whenever a file is checked in,
the version number automatically increases by one—and you can view all
external file dependencies occurring in the file. This could include externally
referenced drawings, images, XML surfaces, and Land Desktop Triangulated
Irregular Network (TIN) and PNT surface files.
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The Vault Administration tool also lists all drawings where the selected file is
used as a reference and displays DWF versions of the drawing files, so you can
quickly find the version you need.

You can use the Vault Administration tool to conduct many administrative
activities. For example, an Autodesk Vault administrator can set up working
folders and enforce their location—such as in individual folders on the server,
shared ones on the server, or folders on individual computers, as explained
previously.

The Vault Administration tool can also be used to create a secure working
environment by assigning unique user accounts and passwords for a particular
vault. You can add and edit users or groups of users. You can also assign roles
and permissions to individual users and folders within a project, defining
what actions they can take and what vaults they can access. For example, one
group of users with Autodesk Vault consumer permissions can get read-only
copies of project drawings while another group with editor permissions can
create and edit them.
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Using the Vault Administration tool, you can also easily restore a previous
version of a file—a helpful process when a client decides to go back to an
earlier design iteration—without restoring the entire project. If you need to
start a new drawing using an existing drawing as the basis, you can use the
Vault Administration tool interface to do this without opening the drawing.
It’s as easy as right clicking on a drawing name, selecting the Copy Design
option, assigning a new project for the drawing, and naming the new drawing.

You can also use the Vault Administration tool interface to label project
milestones for easy identification. Firms often need to submit deliverables to
a client at certain levels of completion, such as 30%, 50%, and 75% completion
intervals. For a 30% complete submittal, you can label all drawings in a project
“30%.” When you create this new label, the most recently checked-in version
of every file in the project and all reference files are assigned the label. If, at
a later time, you need to restore the 30% completion project files, you can
easily restore the project to this milestone by simply restoring the 30% label,
instead of doing it drawing by drawing.

Another helpful administrative task that you can perform is Pack And Go, in
which a label and all of its referenced files are combined into a single package
and sent to either a folder outside the vault or to an e-mail recipient. All files
referenced by a selected label are automatically included in the package unless
otherwise specified. You can use Pack And Go functionality to archive a file
structure, copy a complete set of files while retaining links to referenced files,
isolate a group of files for design experimentation, or send a data set to e-mail
recipients, such as subcontractors or clients.

Because Autodesk Vault allows you to store every electronic file related to your
project—such as Microsoft Word documents, e-mails, spreadsheets, and design
outputs from third-party applications—you should also use the Vault tool
when you need to manage files that are not AutoCAD software-based or Civil
3D drawings.
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It is not recommended that you use the Vault Administration tool interface
to check in or check out drawings that contain Civil 3D data. In the rare case
that these drawings do need to be managed in this way—for example, when
an employee may be out sick or unavailable, and yet they still have files
checked out of a project—an administrator can force a check-in of the files
through the Vault Administration tool interface.

Microsoft Office

You can access Autodesk Vault from within Microsoft® Word, Microsoft®
Excel, and Microsoft® PowerPoint® applications. When Microsoft Office is
installed on the same computer as Civil 3D and an Autodesk Vault client, the
File menu for these three Microsoft applications is automatically customized.
An Open From Vault command and an Autodesk Vault submenu are both
added to the File menu, as shown in the following illustration. Using these,
you can log in to Autodesk Vault and check in documents from within the
Microsoft application.
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Backup Procedures

This section discusses the issues to be aware of for implementing backup
systems for data that is maintained by Autodesk Vault.

If you are using Autodesk Vault, it is critical to have a secure, reliable system
in place for backing up project data. Without an appropriate backup system,
your project data may be seriously compromised if an unforeseen event occurs,
such as the accidental deletion of data or projects, file corruption, or power
outage. Because of the live SQL database Autodesk Vault employs, you cannot
back up Autodesk Vault data using a tape backup device on the Autodesk Vault
database and file store.

To back up your data, you must use the Vault Manager, which is a set of tools
within Autodesk Vault for maintaining users and vaults. Using the backup
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routine in Vault Manager ensures that the database and file store remain in
sync with each other. You will need the user name and passwords of your
Autodesk Vault administrator to run the backup process. After the backup is
complete, you can direct your tape backup system to the Autodesk Vault
backup directory for archiving. To make backups easier, you can have this
procedure automatically occur on a regular basis, using scripts.

Because your drive space may be limited, you may occasionally need to purge
old file versions. For example, on the file server, the Vault file store keeps a
version of each document that has been checked into the Vault database. You
should keep everything that you may need to reference later, as well as some
versions for archival and milestone purposes. To allow adequate drive space,
you may want to institute a process for purging old files at set intervals based
on your firm’s workload.

To purge your data, use the Purge Wizard. Only users with a role of
Administrator can perform this function. You can purge a certain number of
versions, purge versions older than a given number of days, or exclude versions
with a specific notation.
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Civil 3D Workflow with Autodesk Vault

This section discusses how you can use Autodesk Vault to create an efficient
project management workflow in Civil 3D. Note that this type of workflow
can also be created using data shortcuts.

For most civil engineering projects, multiple team members need parallel
access to design data. With Autodesk Vault, you protect data sharing
throughout the project life cycle and streamline the design process by ensuring
that your team stays coordinated and each member gets the project data he
or she needs without having to wait for the next person to finish. The following
illustration, and the sections that follow, provide details of a suggested
workflow for using Civil 3D and Autodesk Vault to help your teams work
collaboratively and efficiently.

Top Level Production Sheets

Level3 Engineering Plan
Level 2 Base Drawing Base Drawing
Design Design Design Design
Level1 Object Object Object Object

This workflow consists of three levels as illustrated in the preceding illustration.
In Level 1, you create individual design objects, such as alignments, surfaces,
and pipe networks. These provide the foundation on which the rest of your
project is built. After you create your design objects and check them in to a
vault, you use data references to reference these object drawings to create base
drawings in Level 2. Data references are essentially shortcuts that point to
individual objects in a drawing. These shortcuts can then be loaded into other
drawings, creating a “reference” of the object that a user can stylize and use

Civil 3D Workflow with Autodesk Vault | 113



for more design work, but can’t edit. This allows you to share your design
objects across multiple drawings. When you edit a design object (Level 1),
drawings that reference the design object (Level 2 and Level 3) are also updated.

For example, you can design all of your individual alignments in Level 1, and
then data-reference them in Level 2 to create a geometric base drawing. The
same process is true for items like surfaces (Level 1) and topographic plans
(Level 2), as well as pipe networks (Level 1), and a utility base (Level 2). It is
also important to note that you need to combine data references and external
references (xrefs) in order to include all project information in your drawings.
For example, to create a proposed alignment and profile drawing, you would
need to combine a data reference of the existing ground surface with an
external reference of the existing conditions plan (containing AutoCAD
entities).

Once you have checked these Level 2 base drawings in to a vault, you can
create a production sheet (Level 3), such as a plan and profile sheet, by using
external references to combine the base drawings. By maintaining this drawing
structure, you can take maximum advantage of the dynamic model that is
integral to Civil 3D. That is, when a change is made to any of the objects in
Level 1, it is automatically reflected in both your Level 2 base drawings and
Level 3 production sheets.

By using this workflow, you also take advantage of the dynamic link between
labels and referenced objects in Civil 3D. This ensures that all your annotation
is synchronized throughout all the drawings in the project.
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Using xrefs, combine base sheets and
engineering plans to create production sheets

Production Sheets
Level 3
Plan and Profile Utility Sheet Landscaping Sheet
Using data references and xrefs, combine existing Civil 3D design objects
with AutoCAD linework and geometrics to create engineering plans
that include proposed design objects
Base Drawings Linework and Geometrics
Topograph M
pography Utility Base AutoCAp A_utoCAD
Base == | Geometrics Linework
Grading Base Road Base AutoCAD AutoCAD
Level 2 Linework Geomterics
Engineering Plans
Engineering Plans, Engineering Plans,
Design Plans Design Plans
—
—
Engineering Plans, Engineering Plans,
Design Plans Design Plans
Using data references, combine Civil 3D design objects
to create hase drawings.
Civil 3D Design Objects
Level 1

Il Profiles ¥ Alignments & Surfaces q;f Pipe Networks

The previous illustration shows that in Level 1 you can combine design objects
to create base drawings in Level 2 using data references. In Level 2, you create
engineering plans by combining design objects with linework and geometry.
In Level 3 you can combine base sheets and engineering plans to create
production sheets.

The following sections explore each level of this workflow in more detail.
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Level |: Creating Individual Design Objects

In the first level of the workflow, you can set up the source drawing—the
drawing in which the object is created and stored—in one of two ways. You
can either create one object per drawing, or you can include several objects
in a single drawing. Use the following sections to help you decide how to set
up your source drawing, and how to manage drawings, survey data, and points.

Using data references, combine Civil 3D design objects
to create base drawings.

Civil 3D Design Objects

Level 1
bl Profiles “2 Alignments & Surfaces qénf Pipe Networks

One Object, One Drawing

In this scenario, you save each design object in its own drawing. If you know
that team members will have to share or edit an object at the same time, it is
recommended that you adopt the one object, one drawing approach. Autodesk
Vault controls data-sharing using the source drawing from which a design
object is created. If you place two or more design objects in the same source
drawing, only the user who has checked out the drawing from a vault can
edit the design objects. In effect, a drawing locks any design objects contained
in it, so that only the user who has checked it out can make changes. Therefore,
to allow multiple people to edit multiple design objects, you need to place
the objects in separate drawings. For example, if your project design has five
alignments and multiple team members need to edit these alignments
simultaneously, then you need to store each alignment in its own drawing.
By doing so, each team member with write access can edit the alignments as
needed, while other team members can still concurrently reference the
alignments for other design tasks.

The one object, one drawing approach allows you to continue to share objects
collaboratively among team members, like you may have done with Land
Desktop. The main difference is that with Land Desktop, anyone working on
a project can edit objects. With Civil 3D and Autodesk Vault, you can set roles
and permissions for individual users, defining what actions they can take. By
using the one object, one drawing approach in Civil 3D, as many people as
possible can work simultaneously on projects in a secure way. The extra time
it takes to create and name a new drawing for each new design object is
minimal—and you gain the ability to keep your project progressing quickly.
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Multiple Objects, One Drawing

If you have only a few team members who will edit a design, you do not need
to follow the one object, one drawing approach. You may choose to keep
some design objects together in a source drawing when creating a Level 1
drawing. For example, if you have several pipe networks in your design, but
only one person on the design team is responsible for designing and editing
these, then you can store all the pipe networks in the same drawing. When
that drawing is checked in to the project, all of the pipe networks are available
for reference by other team members. Taking this multiple objects, one-drawing
approach can reduce the amount of drawings in a project and provide a single
source for editing.

Other Considerations

There are several guidelines you should follow when managing drawings in
Level 1 of the workflow. These practices apply whether or not you use the one
object, one drawing or multiple objects, one drawing approach.

For each drawing you create, you need to assign a unique file name and save
it to the designated project working folder in Autodesk Vault (see Setting Up
Working Folders (page 105) for more information about setting up the project
folder structure). It is recommended that you do not use the default file names.
Instead, provide a unique name for each drawing with a clear reference to the
object it contains (for example, Maple_Street_Centerline.dwg). To check your
drawing and object data in to the vault, you’ll use the Add To Project wizard
that is part of the Civil 3D project management functionality.
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This wizard will guide you through the entire process. Consider the following
options when checking in your drawing:

B Check in not only your drawing, but all file dependencies as well. This
may include external reference drawings, LandXML files, TIN files, and so
on.

B Leave the Keep Files Checked Out option selected if you want to save the
drawing to a vault, but continue to work on it.

B Create a DWF snapshot of the file so you can quickly see its contents should
you need to find the drawing several revisions later.

B Add aversion comment that may help you remember the attributes of the
version (for example, noting whether a survey has taken place, or including
the date).

B Select the object as “shareable,” so that other team members can use a
reference copy of the object in other drawings.

Repeat the process of creating, saving, and checking in design objects as
described above. After you have created your design objects— either one object
in its own drawing, or multiple objects in a single drawing — you can
data-reference them to create base plans, such as a utility base or grading base,
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or combine them with externally referenced AutoCAD linework and geometry
to develop proposed design objects —tasks that you perform at Level 2 of the
workflow.

Survey Data

Civil 3D uses a unique database called the Survey Database to store, manage,
and edit survey information. This database is created outside the Autodesk
Vault environment, but is stored in the working folder with all other project
data. When you need to add survey data to your project, just check the
database into the project. This will make all of the points, figures, and
observations stored in the database available for use by other team members.
You can manage the survey database once it is checked in to a project using
the Civil 3D Prospector tab in Toolspace.
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Once you have the Survey Database checked out, follow these steps:
1 Open the Survey Database from the Survey tab in Toolspace.
2 Add survey data by importing or manually creating it.
3 Close the Survey Database on the Survey tab in Toolspace.
4 Check the Survey Database back in to the survey project using the

Prospector tab in Toolspace.

Points

Like survey data, project points are not stored in a source drawing and must
be managed differently from other design objects. Master copies of points are
stored in a point database and then, as a subset of the project database, project
points are checked out or copied directly to a drawing. Because the project
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database does not display individual points, you cannot view them using the
Vault Administration tool interface. However, you can check out, modify, and
check in individual project points rather than the entire project point database.
When you modify and check back in a point, the project database updates
automatically.

Level 2: Creating Base, Linework, and Engineering
Drawings

After you create your design objects and check them in to a vault, there are
several types of drawings you can create in Level 2 of the workflow. These
include base, linework, and engineering drawings.

Using data references and xrefs, combine existing Civil 3D design objects
with AutoCAD linework and geometrics to create engineering plans
thatinclude proposed design objects

Base Drawings Linework and Geometrics
Topography . AutoCAD AutoCAD
Utility Ba
Base ity Base -+ Geometrics Linework
Grading Base Road Base AutoCAD AutoCAD
Level 2 Linework Geomterics

Engineering Plans

Engineering Plans,
Design Plans

Engineering Plans,
Design Plans

Engineering Plans,
Design Plans

Engineering Plans,
Design Plans

Base Drawings

Base drawings are created by combining Level 1 Civil 3D objects by
data-referencing them. You can then use base drawings as external reference
files for site feature plans or for plan sets (sheet sets), such as an existing
condition drawing that includes survey data and a surface model.

Linework Drawings

Creating linework drawings is sometimes an intermediate step between
developing engineering plans and base drawings. Linework drawings contain
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the linework and basic AutoCAD objects (such as lines, text, and blocks) that
are used to build or represent existing conditions. Although linework drawings
do not include Civil 3D objects, you can still add linework drawings to the

project so that you can manage and reference them later on in the workflow.

Engineering Plans

Engineering plans—such as corridor designs, grading plans, or site plans—result
from combining design objects to create or “engineer” other design objects
for your project. For example, if you want to design a corridor model, you can
create a drawing that references—from Autodesk Vault—both an alignment
with its profile and the existing ground surface. With engineering drawings,
you take advantage of the work done on objects in Level 1 while leveraging
the powerful Civil 3D design tools. In a multi-user environment, engineers
and designers are able to reference core objects from the project, while at the
same time, technicians and drafters can create plan sets and conduct drafting

as required.
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The following steps describe the basic phases you would go through to create
an engineering drawing. This example assumes you are creating a corridor
design.
1 Create a new drawing and add it to the project. Once a drawing has been
added to your project, it will appear on the project tree on the Prospector

tab in Toolspace. For this example, we will store the corridor drawing in
a folder called Engineering Plans. Each project will contain collections
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of objects. For example, alignments will be in the alignment collection,
surfaces in the surfaces collection, and so on.

2 Data-reference the existing ground surface into the drawing by expanding
the surfaces collection and creating a reference. This will import a
reference of the surface from the project into your current drawing,
allowing you to use the data for design work.

3 Apply styles and annotation to the referenced surface as desired.

4 Repeat the process of data-referencing for the alignment and profile.
When you finish, you have the components needed to begin your corridor
design.

5 Synchronize with the project, so that if any of the data references have
been edited, the updates will be instantly reflected in your design. This
allows you to keep your designs in sync across multiple users and multiple
drawings.

6 After you create your design—in this case the corridor model and finished
road grading—check it in to a vault. You can now share the new surface.

Repeat this process for all other base, linework, and engineering drawings you
create to complete Level 2 of the workflow.

Level 3: Creating Top-Level Production Sheets

After you have developed the base, engineering, and linework drawings, you
are ready to create a production sheet or a plan set drawing, such as a plan
and profile, utility sheet, or landscaping sheet. When you produce many of
these for a single project, they are sometimes referred to as a sheet set.

Using xrefs, combine base sheets and
engineering plans to create production sheets

Production Sheets

Level 3
Plan and Profile Utility Sheet Landscaping Sheet

To generate these top-level (Level 3) sheets, you will need external references
of your base, engineering, and linework plans together in to a plan set drawing
that can be used for generating layouts with title blocks and final drafting.
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Before you create external references for these drawings, you must make sure
that you are accessing their latest versions. In Civil 3D, external references are
accessed for project drawings (drawings that are part of the Autodesk Vault
project) from your working folder. Therefore, you need to make sure that the
latest versions of all drawings are in your working folder. To do this, find your
project in the project tree on the Prospector tab in Toolspace. Right-click on
the project name and choose Get Latest Version. This step pulls the most
recent versions of all project drawings and design objects into your working
folder. After you have the latest versions of all project drawings and objects,
you can create your Level 3 production sheet(s).

. Get Latest Version - Test

Include file dependencies
= @[] Test
= 7 [7] Drawings
i@ [] External References
i#? [] Source Drawings
3§ [¥] Drawingl.dwg
&4 [7] Drawing2.dwg
34 [¥] Drawing3.dwg
4 Paints
T[] survey Database

o] | [ Cancel ] [ Help

Create the Plan Set Drawing

Let’s assume you are working on a plan and profile sheet. First, you create a
new drawing, name it, and save it to your working folder. Once it’s saved,
check it in to a vault so that the drawing will be part of the project database.
Make sure to choose the Keep Checked Out option so you can keep working
on it. Use the XREF command to externally reference the appropriate Level 2
drawings, such as base linework, base utility, and base topology. When you
create a top-level drawing in Level 3, the data you created in the Level 2
external references—including object data and label styles—are display-only.
However, you can use the Layer Manager to hide and display the external
reference layers. When you finish creating your external references, you can
check the drawing in to a vault, while making sure to select the Include All
File Dependencies option. This ensures that all associated file dependencies
will be copied to their working folders when other team members check out
the plan set drawing. You will typically use a plan set drawing when using
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the AutoCAD Sheet Set Manager. You can also use the Plan Production Tool
wizards in Civil 3D to automatically create these sheets.

Additional Drafting and Annotation

Sometimes you need to edit or add annotation to a design object during Level
3 of the workflow. To add annotation, just reference the appropriate design
objects into your plan set drawing from the vault as data references, and apply
the needed annotation or drafting. This gives you control over the stylization
and annotation of the objects in the plan set drawings. Therefore, you are
able to take advantage of the work done in Level 1 and Level 2 of the workflow,
while also allowing your drafters and technicians to finalize the annotation
and Level 3 sheets needed to produce a full set of construction documents.

Addressing Interference

When drawings from Level 1 and Level 2 are externally referenced into Level
3, you may find that there are annotation interferences. If this happens, you
can either use Layer Manager to turn off the interfering text, or you can create
data references of the design object in the Level 3 drawings and control its
annotation there. Using this approach, the Level 3 drawings can be
synchronized to reflect any changes that take place in lower levels. While
creating references in Level 3 requires some duplicate work, it is negligible
compared to the benefit of having the top-level sheets in sync with the design.

Working with Images

You may need to incorporate an image into your top-level production sheet.
For example, a rough grading plan sheet may include aerial photographs. To
add an image, create the drawing as recommended (name it and save it to the
working folder), attach the image (through the External References Manager
or by using AutoCAD Raster Design), and then check the drawing in to a vault,
making sure to select the Keep All File Dependencies option. By selecting this
option, you include all file dependencies and avoid broken references. After
completing this process, the drawing and attached image will be saved in the
vault.

Bypassing Level 2

You may be able to complete some projects without going through all levels
of the workflow. In particular, you may not need to create any intermediate
drawings in Level 2. Instead, you may be able to create top-level sheets by
directly data-referencing individual objects created in Level 1. The benefit of
bypassing Level 2 drawings is that you can do labeling directly in the Level 3
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drawings, avoiding the possibility of generating interferences. The downside
of bypassing Level 2 is that you remove the option of combining objects from
Level 1 with engineer or design elements—such as corridors or utilities—on
design data.

By adopting a workflow like the one just outlined, you make it possible for
your teams to work securely and collaboratively—so they can finish civil
engineering projects faster. When you use Autodesk Vault to manage project
data, you extend the dynamic object updates that occur within a single Civil
3D drawing across multiple drawings. Using the powerful Civil 3D design
tools to create your designs along with using Autodesk Vault to facilitate
collaboration and to control access to project files, you minimize manual
work, reduce errors, and complete plans more quickly and easily.

Assessing Your Workflow

Now that you understand more about how you can use Civil 3D project
management capabilities to create an efficient workflow, you need to assess
your own organization and workflows to determine what can best suit your
needs.

Depending on complexity, an organization’s project management needs may
range from needing to manage a few drawings in a folder to needing to manage
a large database with many shared objects, security controls, and a large
number of users. When deciding on which methodology to use for managing
your projects, start by analyzing these factors in your organization:

B Your general workflow
B The number of drawings typically managed

B The complexity of drawings typically managed (the number of objects and
object types that are typically contained in the drawings)

B The size of the project team (the number of people requiring access to the
files) and how many teams you have

B The need to balance the relative ease of use (simplicity of workflow) as
opposed to the need to maintain data security

You can always contact an Autodesk representative for assistance in

determining which project management solution is right for your organization.

To learn more about how you can use Autodesk Vault with Civil 3D to manage
your civil engineering projects, visit http://www.autodesk.com/VaultForCivil3D.
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The Next Move

Now that you have explored the issues involved with moving from Land Desktop to Civil
3D, you may be wondering what your next step should be.

If your organization has already made the commitment to move from Land Desktop to Civil
3D, the next step may already be clear. Teams and individuals may be ready to move on to
exploring other training resources, like those listed in Chapter 1. Or perhaps you are ready
to contact your Autodesk representative for guidance.

If you still need to convince others in your organization that making the move is the way to
go, pointing them to this guide may be the next step.

If you are ready to begin your first Civil 3D pilot project, you will be joining the many other
Autodesk customers who are happy they made the switch from Land Desktop to Civil 3D.

Learn More or Purchase

Access specialists worldwide who can provide product expertise, a deep understanding of your
industry, and value that extends beyond your software purchase. To purchase AutoCAD Civil
3D software, contact an Autodesk Premier Solutions Provider or an Autodesk Authorized
Reseller. To locate the reseller nearest you, visit www.autodesk.com/reseller. To learn more about
AutoCAD Civil 3D, visit www.autodesk.com/civil3d.

Autodesk Services and Support

You can accelerate your return on investment and optimize your productivity by using the
innovative purchase methods, companion products, consulting services, support, and training
that are available from Autodesk and Autodesk authorized partners. These tools are designed
to get you up to speed, keep you ahead of the competition, and make the most of your software
purchase—no matter what industry you are in. To learn more, visit
www.autodesk.com/civil-support.

Autodesk Subscription

Autodesk® Subscription gives you the benefits of increased productivity, predictable budgeting,
and simplified license management. You get any new upgrades of your Autodesk software,

127


www.autodesk.com/reseller
www.autodesk.com/civil3d
www.autodesk.com/civil-support

and any incremental product enhancements, if these are released during your subscription
term. You also get exclusive license terms that are available only to subscription members.
A range of community resources, including web support direct from Autodesk technical
experts, self-paced training, and e-Learning, help extend your skills. Autodesk Subscription
is the best way to optimize your investment. To learn more, visit
www.autodesk.com/subscription.
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